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1. Welcome to TimeTiger 
 
Welcome to TimeTiger! 
 
TimeTiger has been designed with three important goals in mind: 
 
• Fast, easy time entry that makes it painless for you to log your work. 
• Powerful analysis and reporting tools that help you understand your work. 
• Flexibility and power that let you use that information to improve the way you do work. 
 
You'll see just how easy it is to enter time information, and the powerful reporting tools will help 
you learn about your own activities. To begin, see Getting Started. 
 
For a listing of help topics, click on the Contents button above. 
 
For the latest information on TimeTiger or to get help with the system, connect to the TimeTiger 
web site http://www.timetiger.com. 
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2. TimeTiger Overview 
 
2.1. Getting Started 
 
Note: At any time, right-click on the TimeTiger clock icon in the Windows system tray at the 
bottom-right corner of your screen to bring up the TimeTiger QuickPick window. The QuickPick 
window gives you instant access to the most commonly used TimeTiger features. 
 
For information about using TimeTiger after it has been installed and set up, see QuickPick 
Overview. 
 
For information about installing TimeTiger for use on a network or your own computer, see 
Database Connection Overview. 
 
For information about creating and configuring a brand new database for your organization, see 
Setup Wizard. 
 
For information about adding Clients, Projects, Tasks, and Categories to a database to prepare it 
for use, see After the Setup Wizard. 
 
For general information about TimeTiger and what it can do for you, visit www.timetiger.com. 
 
Once TimeTiger has been setup, and you're ready to start using it, the most important thing you 
should learn and get used to is time entry using QuickPick. Please go to that section first. After 
you've mastered time entry, you can learn about other areas, such as Reports, Administration, 
and changing TimeTiger Options.  
 
Note: If you are not logged in to TimeTiger as a system administrator, you will have limited 
access to the system and will not be able to change system options. 
 
  
  
  
 
2.2. Sample Data Overview 
 
Note: At any time, right-click on the TimeTiger clock icon in the Windows system tray at the 
bottom-right corner of your screen to bring up the TimeTiger QuickPick window. The QuickPick 
window gives you instant access to the most commonly used TimeTiger features. 
 

To learn how to start logging time right now in the Sample database, see QuickPick Overview. 
 
TimeTiger comes with a sample database to show you how a company could set up their 
installation. If you selected the 'Use Sample database" during the setup of TimeTiger, you can 
now view the sample company's setup of TimeTiger. The sample database contains 
information from October 1998 to October 2001, with the majority of data in 1999 and 2000. 
Please use dates in this range for reporting. 
To see how the sample database has been configured, right-click on the TimeTiger icon in your 

system tray. Then click on the Explorer button . For more information about the TimeTiger 
Explorer please refer to the Administration section. 
 
The sample database provided is for a company which contains Clients, Projects, Tasks, and 
Categories. 
 
The sample database is set up with Overtime data for Regular Overtime and Extra Overtime - see 
the section on Options-Timers for more information on how Overtime and Extra Overtime work. It 
is not set up with supervisor approvals. To learn about this topic, see Supervisor Approval. 
 
Each of the users in the database have no passwords, and all have administrative privileges so 
they are allowed to both view and change the data. To find out what a user without Admin 
priveledges can and cannot do, see the Section on Properties-Users. You can also change a user 
to a non-administrator - see the Explorer section. 
 
The users are: 
 
Steve 
Chris  
Dave 
Jane  
Jason 
Jorge 
Ken 
Sample 
Theresa 
 
Expand the Categories to view the categories which are being used for this company. The 
categories you set up for your own organization need not be the same as those listed here. 
 
You can use the Report Wizard to get more information about the company and do some analysis 
on where it has been spending its time. For more information on Reporting please refer to the 
Reports section. 
 
Note: To reach this section in the future, Choose Help...Help Topics from the Explorer window 
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and select "Sample Data Overview" from the Topics at the left. 
 
  
  
  
 
2.3. QuickPick Overview 
 
This is the TimeTiger QuickPick window: 
 

 
 
The QuickPick window shows you a list of all the different things you could be working on during 
the course of your day. In TimeTiger, we call these Timers. You can have as many timers as you 
want, and you can create a timer for each of your various activities and responsibilites. Once you 
have created these timers, keeping track of your time is as simple as clicking on the activity you 
are currently working on. 
 
In the example above, you can see that we are currently working on Fusion web mktg. The timer 
is running, as indicated by the clock to the left of the timer description. So far, 1.8 hours has been 
spent on this task. When we begin working on Berk Development, we just click on that timer. The 
Fusion web mktg timer stops and the Berk Development timer continues from where it left off. 
 
The (Nothing) timer is used for time you spend that is not related to work. If you go on a break, for 
example, click the (Nothing) timer before you leave.  
 
At a convenient time (typically at the end of each work day), transfer your time from the QuickPick 

window into the TimeTiger database by clicking the Log Time button . Note that your time 
logs will not appear in any TimeTiger reports until you log them to the database. For more 
information on this step, see Log Time Overview. 
 

To add a new timer to your QuickPick list, click the New Timer button . 

 

To edit time already logged in the database, click the Edit Time button . 
 
To launch the TimeTiger Explorer, where you can do reporting and system administration, click 

the Explorer button . 
 
To see a menu of options related to a specific timer, right-click on the timer itself. 
 

To see other TimeTiger options or to exit TimeTiger, click on the TimeTiger Paw button . 
 
Note: if you close the QuickPick window, you haven't actually quit TimeTiger. To get QuickPick 

back, just right-click on the TimeTiger clock icon  in your Windows system tray at 
the bottom-right corner of your screen. TimeTiger is designed to always be running on your 
computer, giving you instant access to time logging features. To actually exit TimeTiger, click on 
the TimeTiger Paw button and choose Exit TimeTiger from the menu. 
  
  
  
 
2.4. Add/Edit Timer Overview 
 
This window allows you to add or edit timers in your QuickPick list. You must enter a name for the 
timer as it will appear in your list, and you must also fully categorize the timer by assigning it a 
Client, Project, Task, and/or Category. This way, when you log time to this timer, it can be 
automatically categorized in the TimeTiger database. 
 
If you do not see the item you wish in the list presented to you, click the Add button to create it. 
Note that only TimeTiger Administrators can add items in these lists. 
 
If you are an administrator you can also create timers for users other than yourself. The timer you 
create will be added to the other user's QuickPick timer list the next time they start TimeTiger or 
when they choose Refresh from the paw menu in their TimeTiger QuickPick menu. 
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2.5. Log Time Overview 
 
The Log Time window transfers time you have been tracking in your QuickPick timers to the 
TimeTiger database. To Log Time, click on the QuickPick Log Time button or simply double-click 
on the TimeTiger clock icon in your Windows system tray. 
 
The Log Time window is automatically filled in with the timers from your QuickPick list. You can 
take this opportunity to adjust and review entries, add new entries, and fill in a descriptive note 
about the work actually completed in the Status/Description field. 
 
To remove a timer you do not wish to log right now, simply change its Time to 0.0. 
 
The top section of the Log Time window shows you three "Auxiliary" timers. These timers do not 
appear in your standard QuickPick list, but you can see them in the QuickPick window by 
choosing "Show Auxiliary Timers" from the Paw menu. The Main timer shows the total time since 
you last logged time to the database. You can use Timer 1 and Timer 2 to track an activity that 
you do not wish to create a QuickPick timer for. You can start and stop Timer 1 and Timer 2 from 
the QuickPick window. 
 
Tip: Try using the keyboard to navigate through this window. The TAB key moves to the next field 
and the ENTER key clicks the OK button. The arrow keys move you around the window. 
 
Note: You can change the date you are logging time for by clicking the ... button at the top of the 
window. You can only log time for one date at a time. 
 
  
  
  
 
2.6. Edit Time Logs Overview 
 
This window lets you edit your time entries and the time entries of the people who report to you (if 
you are their supervisor). When supervisor approval is not enabled, you can only edit your own 
time. Supervisor approval is defaulted to OFF. To enable it, see the section on Supervisor 
Approval. If supervisor approval is enabled, the Time Log entries will be different colors 
depending on if they're approved or denied. You also have more toolbar options if supervisor 
approval is enabled. For more information about Supervisors, see the section called Supervisor 
Approval. Below is a list of the colors lines might be: 
 
• White - Normal time log entries that have not been reviewed by a supervisor 
• Red - Denied time log entries - when you click on these, a note will appear at the bottom of the 

screen telling you why the entry was Denied 

• Green - Time that has been approved by a supervisor 
• Grey - Time that appears on an invoice - it cannot be edited anymore 
 
As stated above, Clicking on a denied entry will show a note at the bottom of the screen saying 
why your supervisor denied the time. Correct the entry. As soon as you edit anything and move to 
a different line, the entry will turn white again, signaling that the time is unreviewed. The note will 
also disappear. 
 
To edit time, you select a user from the list at the left of the window. You can then select what 
type of time to show (Approved, Denied, Not Reviewed, All) by choosing from the dropdown list at 
the top of the window. You can also sort the time logs by clicking on the column heading you wish 
to sort by. 
 
To edit one or more entries, select them using the mouse (hold down the Ctrl key to select 
multiple entries, or the Shift key to select a group of adjacent entries). Then click on the 
Properties button on the toolbar. The Edit Time Logs window will appear, and you can change 
any or all of the time log information. 
 
To delete an entry, select it and click the delete button:  or hit the Delete key on the keyboard. 
 
Note: As a top-level supervisor, your time is automatically approved by TimeTiger (appears 
green). this is normal, and you can still edit it. For supervisors who have a supervisor above 
them, your time will still be white, and will require approval. 
  
  
  
 
2.7. R&D-Overview 
 
TimeTiger allows you to track the amount of time spent on R&D, as well as answers to the five 
questions on a Canadian R&D Tax Credit form T661 (E). If you wish to track R&D Project 
information, go to the Tools...Options...Advanced area of the Explorer window and enable the 
R&D checkbox. 
 
This will add five tabs to the Project Properties window when you're creating or editing Projects in 
the Explorer window. Each of these tabs corresponds to each of the questions on form T661 (E). 
This way, you can write up your Project objectives, etc. and store them with the Project. 
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3. Installation 
 
3.1. The First Time You Run TimeTiger 
 
When you run TimeTiger for the first time you will be asked to accept the license agreement, and 
then you will be asked if you would like to install a shortcut into your Startup group for TimeTiger. 
If you answer Yes, TimeTiger will run every time you turn on or restart your computer. 
 
Next, you are asked to help TimeTiger find your database. The TimeTiger software application 
must be installed on every machine at your organization that will be using TimeTiger, but the 
TimeTiger database is only set up at one location on your network. The TimeTiger software 
running on each workstation connects to that same shared database so that everyone at your 
organization is logging time in the same database. Of course, if you are using TimeTiger yourself, 
you can just store the database on your computer and only you will have access to it. 
 
If you have downloaded TimeTiger for the first time and would like to evaluate it, you can either 
Setup a new TimeTiger Database or you can Use the Sample database. 
 
If a TimeTiger database has already been set up for you by a system administrator, you should 
Locate a TimeTiger Database. 
 
If you are the person responsible for setting up a TimeTiger database on your network, you will 
need to either Setup a new TimeTiger Database or Convert/Upgrade an Existing TimeTiger 
database. 
  
  
  
 
3.2. Database Connection Wizard 
 
3.2.1. Database Connection Overview 
 
The database connection wizard allows you to create a new TimeTiger database or select an 
existing TimeTiger database to work with. Every workstation on your network should be 
connected to the same TimeTiger database. Your TimeTiger database can be in Microsoft 
Access 2000 format (you won't need your own copy of Microsoft Access... TimeTiger includes 
everything you need already) or you can store your database on a Microsoft SQL Server 
machine. If you use a SQL Server database, you must already have a running SQL Server on 
your network. 

 
Selecting the appropriate database type is an important administrative decision. As a rough 
guideline, TimeTiger works well on a Microsoft Access database for up to approximately 100 
users. Once you pass that, we recommend you switch to Microsoft SQL Server, which can handle 
unlimited TimeTiger users accessing the same database. And if you need the robust, scalable, 
high-performance capabilities of SQL Server, you can use it for TimeTiger configurations down to 
a single-user. 
 
Once you establish a database connection on a particular workstation, TimeTiger will remember 
this connection for the user currently logged in to the workstation. You should not have to re-
establish the connection unless you switch TimeTiger databases at a later date. 
 
If you establish a connection to a brand new TimeTiger database, TimeTiger will automatically 
start the Setup Wizard to help you configure your database for use. 
  
  
  
 
3.3. Setup Wizard 
 
3.3.1. Setup Wizard Overview 
 
The setup wizard has been designed to step you through the configuration of a TimeTiger 
database as easily as possible. We've included help here for you in case you run into a problem. 
Before you see the Setup Wizard you must have connected to a database using the Database 
Connection Wizard. 
 
The Setup Wizard walks through the following steps to create a customized database: 
 
• Timer Resolution 
• Overtime and Supervisor Approval 
• Time Categories 
• Client Billing 
• Administrator 
 
If this document still doesn't answer your question please email us at support@indigo1.com. 
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3.3.2. Timer Resolution 
 
This screen allows you to select how detailed you want the time tracking in your organization to 
be.  
 
For example, if you selected tenths of an hour (6 minute intervals) then your timer would 
increment every tenth of an hour and your billing records would be kept at that level of accuracy. 
Be careful - if you set the increment too high (hours), the timer will only increment (click to the 
next hour) every hour since you last allocated time. This could create meaningless data if you 
switch tasks fairly regularly. 
 
This is also important if you are billing Clients as this is the level of detail that will be presented on 
the invoices and timesheets. 
 
Note: You can change the Timer Resolution later, by accessing the Explorer window and 
selecting Tools...Options. 
  
  
  
 
3.3.3. Overtime and Supervisor Approval 
 
Supervisor Approval 
 
Checking the "Require supervisor review and approval" checkbox causes the time that people 
enter to go through an approval process. A supervisor will be able to view all of the time that the 
people directly reporting to them have submitted and be able to approve or disapprove of time 
before it will appear on reports or invoices. 
 
If you do choose to require supervisor review, you also need to decide whether you want to 
assign supervisors by User Group or by Project. For example, if you want group leaders to 
approve time, then select "User Group." If you want project leaders to approve time, then select 
"Project." 
 
Overtime 
 
The overtime and extra overtime options allow organizations to track the type of time that is spent 
and bill Clients accordingly.  
 
If your organization does not need to keep track of this then you can select "No Overtime" and it 
will simplify the Log Time window for users.  
 

If you track Overtime, select Overtime. If you track two types of Overtime (like Overtime and 
Double-time), choose "Overtime and Extra Overtime". You can then use the Extra Overtime 
choice to track your double-time. 
 
Using these Types (Overtime, Extra Overtime) does not change how the number of hours worked 
is shown in TimeTiger (it doesn't multiply by any factors, such as 1.5 or 2). It simply adds another 
item beside the number of hours that shows whether it was Overtime or not. If you enable billing 
as well, then TimeTiger will multiply user-defined rates by Overtime hours when generating an 
invoice. 
 
Note: You can change these options later from the Tools...Options menu in the Explorer window. 
 
  
  
  
 
3.3.4. Time Groupings 
 
TimeTiger will create different groupings that people can allocate time to.  Note that you cannot 
change these options once you have created the database. 
 
If you wish to track the time you spend working with specific Clients then you will need to check 
the box that says you are working on Projects for multiple Clients. For example, your Clients 
could include Felware Minerals and Hillsdale Communications. Each of these Clients might have 
multiple Projects assigned to them. You can also treat internal departments as Clients if you wish. 
For example, if you wanted to use TimeTiger for internal tracking, each department would be a 
Client: 
 
Client: Marketing 
Project: Developing Balloons 
Task: Research 
 
Client: HR 
Project: Stocks 
Task: Documentation 
 
If you wish to track not just how much time was spent on a Project but also on specific tasks 
within those Projects then you will need to check the box that says you wish to track tasks. For 
example, you could have a Client who had Projects like Billing System and Web Site 
Development. Each of these Projects could have tasks assigned to them like: Initial Proposal, 
Design, Development, Testing, Rollout, etc. If you need this level of detail, check the tasks box. 
The tasks for each Project can vary from Project to Project. 
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If you want to track the category or type of time that was spent on a particular Client, Project or 
task then you can check off the box that allows users to select a category for their time usage. 
For example, categories can include items such as: meetings, documentation, design, phone 
calls, administration etc. This feature is very useful because it allows organizations that use it to 
see what types of work their people are spending time on. Whereas the tasks for each Project 
can vary from Project to Project, categories are global - they apply to all Projects. 
 
EXAMPLE: 
 
If all three boxes were checked, the following structure might be created. 
 
Felware Minerals (Client) 
 Billing System (Project) 
  Initial Proposal (Task) 
  Design 
  Development 
  Testing 
  Rollout 
 Web Site Development (Project) 
  Initial Proposal (Task) 
  Design 
  User Testing 
  HTML programming 
  Testing 
  Rollout 
Hillsdale Communications (Client) 
 Contact Management System (Project) 
  Initial Proposal (Task) 
  Design 
  Development 
  Testing 
  Rollout 
 
Global Categories: meetings, documentation, design, phone calls, administration, marketing 
 
The tasks are different for each Project, but the categories apply to all. 
 
  
  
  
 

3.3.5. Client Billing 
 
The Setup Wizard asks you whether or not you want to handle Client billing in TimeTiger. If you 

say yes, you will be able to create invoices from your time data. 
 
If you answer yes, you will get two more screens with billing questions in the setup wizard. 
 
The first screen asks if you do any Daily or Flat Rate billing. TimeTiger tracks time in hours, but 
you can also invoice Clients in Days, or at a Flat Rate. To enable Billing in Days, click that 
checkbox. To enable Flat Rate billing, click that check box. Each of these adds a button to the 
invoice edit screen to assist in creating that type of invoice. 
 
The second screen asks where you want your default billing rate to come from. You can assign 
different billing rates to different Clients, Projects, User Groups, Tasks, Users, or Categories. To 
enter those rates, edit the item's properties in the Explorer screen. For example, if you bill 
different users out at different rates, you can select User here, and enter rates for each user in 
their properties in Explorer. When you create an invoice for a Client, all time logs will be billed at 
the rate for the User who entered the time log. 
 
Note: You can change these options later from the Tools...Options menu in the Explorer window. 
 
  
  
  
 
3.3.6. Administrator 
 
When setting up TimeTiger, an administrator account will be created which will allow that user to 
enter setup information into the database and change TimeTiger options. This person will need to 
create the Clients, Projects, tasks, as well add users so that other may use the system. 
 
Enter the administrator's user name as well a password (case sensitive) here. You will be asked 
to enter the password again to confirm that you typed it in correctly. Be sure not to lose this 
password or you will not be able to make changes or additions to the system. 
 
Note: You can add additional administrators once TimeTiger is set up. Administrators cannot 
change their own status as an administrator or delete their user record - only other administrators 
can do that. 
  
  
  
 
3.4. After the Setup Wizard 
 
Once you have finished going through the setup wizard for your database, you will be asked to 
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enter the authorization key that Indigo Technologies Ltd. provided you with when you purchased 
TimeTiger. If you are only trying the software and have not purchased it yet, you can enter 
"TRIAL" for a database that will expire in 30 days. If you decide to purchase TimeTiger within that 
30 days, you can change the authorization key in Tools...Options...Advanced. 
 
After entering the key, you will need to set up various items within the database such as: Clients, 
Users, User Groups, Categories, etc. Please refer to the Administration section for more details. It 
describes the Explorer window and how to enter your items. 
 
After the Setup Wizard, TimeTiger will ask you if you want to go to the Explorer window. If you 
click OK, you will automatically be brought to the Explorer window. Otherwise, you can access 
the Explorer by right-clicking on the TimeTiger icon in your system tray, and then selecting the 
Explorer button. 
 
Note: You can only have as many active users as you have licenses for TimeTiger. If you try to 
create an active user after you have used up your licenses, you will be asked to delete a user or 
mark someone as inactive. 
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4. Reports 
 
4.1. Reports Overview 
 
TimeTiger has two types of reports: Standard Reports, and Analysis. The Standard Reports are 
predefined, preformatted common reports. Analysis refers to an analysis grid which you can 
customize to create a countless number of analysis types from the data in the TimeTiger 
database. You can also save you analysis types or choose from a set of pre-defined ones. 
 
All reports and analysis are created with the Report Wizard. See Using the Report Wizard for 
more details. 
 
  
  
  
 
4.2. Using the Report Wizard 
 
All reporting and analysis is handled by the Report Wizard. To get to the Report Wizard, right-
click on the TimeTiger icon, click Explorer, and choose File...Report Wizard from the menus in the 
Explorer window. You can also click on the Report Wizard button on the Toolbar  in the 
Explorer window.  
 
Once you have started the Report Wizard, you can follow step-by-step instructions to create 
reports or analysis types. Like any Windows wizard, the Report Wizard has Back, Next, and 
Finish buttons. After you have made your choices on a screen in the wizard, you can use the 
Next button to go to the next page. When you get to the last step, the Finish button will be 
enabled, and you can click it to create your report or analysis. 
 
After the first screen, the Report Wizard asks you to choose between the following three items. 
Each one is explained here in further detail: 
 
• Standard reports 
Standard reports allows you to choose from a list of reports that are pre-formatted, pre-designed, 
and allow little or no customization. These include Project Performance, Time Log, Timesheet, 
etc. If you choose this selection, please see the section on Standard Reports. 
 
• Standard or previously saved analysis 
Standard or previously saved analysis allows you to choose from a list of previously saved 
analysis types. In TimeTiger, the difference between Analysis and Reports is that Analysis refers 

to a data grid of numbers that is extremely flexible. You have the ability to view your time data in 
many different ways. This option lets you choose from a list of pre-saved analysis, and then make 
changes if you like before printing. If you choose this selection, please see the section on Saved 
Analysis. 
 
• New custom analysis 
New custom analysis allows you to create your own analysis types, so you can save them and 
call them from the Standard or previously saved analysis list. To learn how to create these 
analysis types, see the section on Custom Analysis. 
 
When you have made your selection, click Next, and go to the appropriate Help section - 
Standard Reports Overview, Saved Analysis, or Custom Analysis. 
  
  
  
 
4.3. Standard Reports 
 
4.3.1. Standard Reports Overview 
 
After selecting Standard reports and clicking Next, you will be presented with a list of reports. 
 
Standard reports allows you to choose from a list of reports that are pre-formatted, pre-designed, 
and allow little or no customization. These include Project Performance, Invoice List, Tax 
Summary, Time Log, Timesheets, and Client, Project, Task, or Category Lists. Select the report 
you wish to create and click Next. You can also double-click on the report you wish to create. 
Please see the appropriate help section for explanations on the questions asked to generate 
each report. 
 
If you haven't already read the Reports Overview and Using the Report Wizard, you should read 
those sections to see the difference between Standard Reports and Analysis, and how to create 
Standard Reports. 
 
 
  
  
  
 
4.3.2. Project Performance 
 
This report shows you important metrics on a project in the database. You can see when the 
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project was originally supposed to be started and completed (based on the Estimated Start and 
End dates for the project), and when it was actually started (the first time log made on the project) 
to the latest time log made on the project. You can also see the estimated vs. actual hours spent 
on the project so far, and for each task in the project. On the far right you will see the amount 
invoiced for the project, and your effective billing rate. The effective billing rate is the total amount 
invoiced divided by the number of hours logged for the project so far. 
 
After selecting the Project Performance report, you will be asked to pick a project to generate the 
report for. You can only generate the report for one project at a time. 
 
In addition to the information above, for each task in the project you will see a blue and black bar 
indicating the estimated and actual schedule. The blue bar indicates the timeframe when the task 
was originally scheduled to be worked on. The black bar indiciates the time range of actual time 
logs for the task. Note that these bars only indicate date ranges, and not actual hours worked on 
the task. 
  
  
  
 
4.3.3. Invoice List 
 
The Invoice List is only available if your database has Client billing enabled. This report lets you 
see the invoices you have sent to one particular Client, or the invoices you have sent to all 
Clients. It shows the invoice number, amount, Client name, hours logged for the period of that 
invoice, and the effective rate. This is useful when you bill flat rate or in days. The effective rate 
will show you what your effective hourly rate is (invoice total / hours logged) on each invoice. 
 
After selecting "Invoice List," you will have three choices. You can create a report for a single 
Client (specify it's name here), all active Clients, or all Clients, both inactive and active. TimeTiger 
allows you to make Clients, Projects, tasks, categories, and users inactive (edit their properties in 
the Explorer window). If you select active Clients only, your report will show only the active 
Clients. 
 
Hit Next once you have made this choice. You will then be asked for a date range for the report. 
Enter the start and end dates for this report, or select them using the ... buttons.  
 
When you have made your choices, click Finish. The Report Wizard will generate your report and 
show you what it looks like in a preview window. For information on viewing the report in the 
preview window, and printing the report, see Printing Standard Reports. 
  
  
  
 

4.3.4. Tax Summary 
 
This report is only available if your database has Client billing enabled. It allows you to see how 
much you have billed in taxes from TimeTiger Invoices. 
 
After selecting the report, you are asked for a date range for the report. Enter the start and end 
dates for this report, or select them using the ... buttons. 
 
When you have made your choices, click Finish. The Report Wizard will generate your report and 
show you what it looks like in a preview window. For information on viewing the report in the 
preview window, and printing the report, see Printing Standard Reports. 
 
  
  
  
 
4.3.5. Time Log 
 
This report will show you all time logs, or all time logs for a given subject (Project, User, etc.), 
over a specified period of time. 
 
After selecting "Time Log," you will have two choices. You can create a report for a single subject 
(specify it's type and name here), or all time logs. 
 
After selecting the report, you are asked for a date range for the report. Enter the start and end 
dates for this report, or select them using the ... buttons. 
 
When you have made your choices, click Finish. The Report Wizard will generate your report and 
show you what it looks like in a preview window. For information on viewing the report in the 
preview window, and printing the report, see Printing Standard Reports. 
 
  
  
  
 
4.3.6. Timesheets 
 
If you choose Timesheet as the standard report, you are presented with a number of options: The 
first is whether you want a weekly timesheet or a monthly timesheet. The weekly timesheet 
creates a timesheet form Monday - Sunday. The monthly timesheet shows you an entire month, 
day by day, starting on the first day of the month.  
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Next, select a start date. If you don't select a Monday(for a weekly timesheet), or if you don't 
select the first day of a month (for a monthly timesheet), the system will automatically choose the 
previous Monday or first day of the selected month. 
 
The timesheet report allows you to create timesheets for different items. You can do a timesheet 
for a particular user, a particular Client, a particular Project, and so on. Choose the type of item 
you want to report on in the left box, then choose the particular item in the right box. For example, 
you can choose "User" in the left box, and then choose the name of the user from the right box. 
 
Now choose the items you wish listed down the left side of the timesheet. The timesheet will 
show you how many hours were spent by (or on) the subject each day. For example, if you do a 
timesheet with a particular user as the subject, and list Tasks down the left, you will see how 
much time that user spent on different tasks each day. If you do a timesheet with a Client as the 
subject, and list categories down the left, you will see how much time was spent each day on a 
particular category of work for the particular Client.  
 
When you have made your choices, click Finish. The Report Wizard will generate your report and 
show you what it looks like in a preview window. For information on viewing the report in the 
preview window and printing the report, see Printing Standard Reports. 
 
  
  
  
 
4.3.7. Item List Reports 
 
Each item report (User Report, Project Report, etc.) is basically a report showing all properties 
(from the Explorer window) for those items. For example, if you select the User List report, you 
will get all users and all information about that user: their full name, address, phone, fax, email, 
etc. 
 
After selecting the report, you are asked whether you want to show active data only, or active and 
inactive data. TimeTiger allows you to make Clients, Projects, tasks, categories, and users 
inactive (edit their properties in the Explorer window). If you select active data only, your report 
will show only data for active items. 
 
When you have made your choice, click Finish. The Report Wizard will generate your report and 
show you what it looks like in a preview window. For information on viewing the report in the 
preview window and printing the report, see Printing Standard Reports. 
  
  
  
 

4.3.8. Printing Standard Reports 
 
After choosing the report you want in the Report Wizard, filling out the options, and clicking the 
Finish button, the report you selected will be displayed in your default web browser. You must 
either print the report from your web browser or, if you have Microsoft Excel installed, open the 
file using Microsoft Excel. In Microsoft Internet Explorer, this is as easy as choosing the "Edit with 
Microsoft Excel" option from the browser's file menu. With other browsers, you may need to Save 
the HTML file to your hard disk and open it from Microsoft Excel. 
 
When printing TimeTiger reports, you may need to adjust the paper orientation and margins to 
make your report appear properly on the page. Feel free to experiment with the layout options 
available in your web browser and in Microsoft Excel to make the report look just as you want it. 
  
  
  
 
4.4. Saved Analysis 
 
4.4.1. Saved Analysis 
 
Saved Analysis are analysis types that have already been created using the Custom Analysis 
part of the Report Wizard. There are a number of standard analysis types already saved with your 
TimeTiger database. Note: depending on the database you have set up, you may not have all the 
standard analysis types that come with TimeTiger. For example, if you didn't set up tasks, then 
the analysis types related to tasks will not be shown. 
 
If you haven't already read the Reports Overview and Using the Report Wizard, you should read 
those sections to see the difference between Standard Reports and Analysis, and how get to the 
Saved Analysis screen in the Report Wizard.  
 
To see what the saved analysis types are, select one and click Next. You will then need to 
choose whether you want to show active data only, or active and inactive data. TimeTiger allows 
you to make Clients, Projects, tasks, categories, and users inactive when you edit their properties 
in the Explorer window. If you select active data only, your report will show only the active items. 
 
Select the date range for the analysis and click Finish. This will bring you to the Analysis window. 
If you want to see another type, you should close the Analysis window and go through the Report 
Wizard again. For information on modifying a saved analysis type and printing or saving analysis 
types, see the section on The Analysis Window. 
 
For more information on how analysis is handled in TimeTiger, see the section on Custom 
Analysis.  



TimeTiger 1 
 

 Page 13

 
  
  
  
 
4.5. Custom Analysis 
 
4.5.1. Custom Analysis Overview 
 
TimeTiger allows very flexible, powerful custom analysis. If you haven't already seen the Saved 
Analysis types, you should view them to familiarize yourself with the types of analysis TimeTiger 
can help you create. 
 
All custom analysis types can be saved as well - they get added to the list of saved analysis 
types. 
 
If you haven't already read the Reports Overview and Using the Report Wizard, you should read 
those sections to see the difference between Standard Reports and Analysis, and how to get to 
the Custom Analysis screen in the Report Wizard. 
 
Before you get started creating a custom report, you should read the following so that you 
understand how TimeTiger handles custom analysis. 
 
As you may have seen from the saved analysis types, TimeTiger lets you produce a grid of 
numbers like the following: 

 
The first screen on Custom Analysis in the Report Wizard asks you whether you want to show 
active data only, or active and inactive data. TimeTiger allows you to make Clients, Projects, 
Tasks, Categories, and Users inactive when you edit their properties in the Explorer window. If 

you select active data only, your analysis will show only the active items. 
 
Next, enter a date range for the analysis. This will restrict the number of hours shown in the grid 
to the number of hours worked during the date range you specified. Then click Finish. You will be 
presented with the Design Grid window. At this point, you should refer to the section on Designing 
Analysis Types. 
 
 
 
 
  
  
  
 
4.5.2. Designing Analysis Types 
 
You can set up the design of an analysis grid for a new custom analysis or change the design of 
a saved analysis by using the Design Grid window. 
 
The Design Grid window allows you to define the Row and Column headings in your analysis. For 
example, you may wish to put Project names as your Column headings and User names as your 
Row headings. The result would be a grid where each section of the grid contains the number of 
hours a particular User had spent on a particular Project (over the date range you selected 
earlier). To do this, choose Project in the top selection box under column grouping, and User in 
the top selection box under row grouping. 
 
Now suppose you wanted to group the Projects by Client name. The Design Grid window is set 
up to allow you to define a hierarchy of grouping for your Column headings and Row headings. 
Instead of putting the Project in the first box under column grouping, you would put Client there. 
Then, select Project from the box below Client.  
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The result would be a grid like the following: 
 

 
Here, BK Manufacturing and Fusion are your Clients. RD Project Manager and Report module 
are Projects you are working on for BK Manufacturing. You can see which User worked on which 
Project and for how long. 
 
You can limit your report to certain specific Projects by clicking on the ... button beside Project in 
the Design Grid window. Similarly you can limit the report to certain users by clicking the ... 
beside User. 
 
Tip: Try to keep the grid as simple as possible. Although there are three levels of grouping for 
rows and columns, the grid would be far too confusing to be meaningful if you set all six grouping 
levels. 
 
You can create column and row totals by clicking on the Summary Methods tab in the Design 

Grid window. For more information, see Design Grid - Summary Methods. 
 
To continue with your analysis, click OK. You will be brought to the Analysis Display with your 
grid displayed. 
  
  
  
 
4.5.3. Design Grid - Summary Methods 
 
The Summary Methods screen is the background tab of the Design Grid window. You can select 
methods for how to summarize columns and rows in this screen, as well as how to display the 
data in the grid itself. 
 
Normally, the default summary for an analysis is simply totals at end of each row. You can also 
show totals for each column at the bottom of the grid. To do this, change the "Summary at the 
bottom of each column:" to Total. Note that normally, you will only want to summarize rows or 
columns, not both. 
 
You can also change the actual summary method. Instead of taking a Total, you can count how 
many squares in the grid have data in them, or you can take the average (for information like the 
average # of hours your Projects take to complete). 
 
Lastly, if you want to display the data in each grid square as a percentage of the total for each 
row, you can do that by changing the item in the "Display Data As" box. 
 
Once you have set up your Grid, click OK. You will be brought to the Analysis Display. 
 
 
  
  
  
 
4.6. The Analysis Display 
 
After choosing your custom analysis or designing a new one, your report will be displayed in your 
default web browser. You can either print the report from your web browser or, if you have 
Microsoft Excel installed, open the file using Microsoft Excel. In Microsoft Internet Explorer, this is 
as easy as choosing the "Edit with Microsoft Excel" option from the browser's file menu. With 
other browsers, you may need to Save the HTML file to your hard disk and open it from Microsoft 
Excel. 
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When printing TimeTiger analysis, you may need to adjust the paper orientation and margins to 
make your report appear properly on the page. Feel free to experiment with the layout options 
available in your web browser and in Microsoft Excel to make the analysis look just as you want 
it. 
  
  
  
 
4.7. AutoMailing Analysis 
 
AutoMailing allows you to automatically send Analysis via email on a daily or weekly. To learn 
more about AutoMail, see the AutoMail Overview section. 
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5. AutoMail 
 
5.1. AutoMail Overview 
 
AutoMail allows you to automatically send, via Internet e-mail, a custom analysis to a recipient or 
group on a daily or weekly basis. This powerful tool keeps everyone on the project team in the 
loop without any additional effort. 
 
Although any user can set up AutoMail to send themself reports, only Administrators can set up 
AutoMail for other users and usergroups. In order to send AutoMail reports, users should 
understand how to create and save custom analysis. See Saved Analysis. 
 
To turn AutoMail on, and to configure it, see the section on AutoMail Options. 
 
To change AutoMail options for yourself, see the section on AutoMail for Me. If you're an 
Administrator, and you want to set up AutoMail Options for all users, see the section AutoMail for 
Others. 
 
Tip: To help people get used to tracking their time in TimeTiger, it can be useful to set up an 
AutoMail of each individual's time to be e-mailed to them on a daily basis. This way, they can see 
whether or not they remembered to log their time, and serves as a gentle reminder to log their 
time in the future. 
 
Note: Standard Reports cannot be AutoMailed... only standard or custom analysis. 
 
 
 
  
  
  
 
5.2. AutoMail Options 
 
In AutoMail Options, you can enable or disable AutoMail using the checkbox at the top of the 
screen. If it's enabled, and after you have chosen the analysis you want to send in AutoMail for 
Others, you need to set up when the emails are sent, how to send them, and in what format to 
send them. 
 
The first question asks you where the AutoMail emails should originate from. Choose a user 
whose computer will be used to generate and send AutoMail. 

 
Note: The computer you select must be on and have TimeTiger running on it at the time you 
select for sending AutoMails in order for your AutoMails to be sent. 
 
Next, you need to tell TimeTiger when to send the AutoMail emails. If you selected Weekly emails 
under AutoMail for Others, you will have to specify the day and the time. If you selected Daily 
emails, you will have to specify the time of day. 
 
Note: You should choose a time when the User will not be working. This will minimize the 
chances of TimeTiger interrupting their work when it AutoMails. 
 
Next, choose the name of your Internet SMTP server for sending AutoMail. If you do not know 
this name, ask your network administrator or Internet Service Provider. You must enter a valid 
SMTP server in order to send AutoMail. 
 
When you are finished, hit the Test AutoMail button. This will send you a test AutoMail with a 
simple line of text to let you know that AutoMail is configured properly. You must have your own 
e-mail address entered in your Item Properties in Explorer to receive AutoMail, and to test it. 
 
After testing, hit OK. You can now expect AutoMail. 
  
  
  
 
5.3. AutoMail for Me 
 
Using the AutoMail feature in TimeTiger allows you to receive reports on a regular, user-definable 
time interval as e-mail. Only standard or previously saved analysis can be sent using AutoMail. 
 
To set-up AutoMail for yourself, right-click on the TimeTiger icon. Click the Explorer button. Select 
Tools - AutoMail... Click on the 'AutoMail for Me' tab. 
 
If you are using the sample database there will be an AutoMail entry already set-up for you. From 
this tab, you can Add, Edit or Delete AutoMails that have already been setup. 
 
Add a new AutoMail by clicking the Add button. The first thing you will need to do is select an 
Analysis that you wish to send yourself. You will notice that only standard or previously saved 
analysis will appear in the list of available analyses (to add or edit the saved analysis types, see 
Saved Analysis). Next, select the Date Range that you wish to be included in the Analysis. The 
available ranges are: 
 
All  - this will include all time logs in the analysis each time it is sent. 
Today   - this will only show today's time entries (up to the time the AutoMail is sent). 
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Yesterday - this will only show yesterday's time entries. 
Last 7 days - this will show the time entries for the last 7 days each time the AutoMail is sent. 
Last 30 days - this will show the time entries for the last 30 days each time the AutoMail is 
sent. 
Last 90 days - this will show the time entries for the last 90 days each time the AutoMail is 
sent. 
Last 365 days - this will show the time entries for the last 365 days each time the AutoMail is 
sent. 
Week to date - this will show entries for the curent week, beginning Monday up until the current 
day. 
 
You can then choose to send AutoMail daily or weekly. 
 
The last question asks whether you want to show active data only, or active and inactive data. 
TimeTiger allows you to make Clients, Projects, tasks, categories, and users inactive when you 
edit their properties in the Explorer window. If you select active data only, your report will show 
only the active items. 
 
Once you have created an AutoMail, you can also edit it. To Edit an AutoMail, select it in 
Tools...AutoMail and click on the Edit button or using the mouse, double-click on the row of the 
AutoMail you wish to edit. You can edit any of the AutoMail options described above. 
 
You may also delete an AutoMail from the list by highlighting the one you wish to delete and 
pressing the Delete button. 
  
  
  
 
5.4. AutoMail for Others 
 
Using the AutoMail feature in TimeTiger allows you to send reports to other user groups or users 
on a regular, user-definable time interval as e-mail. Only standard or previously saved analysis 
can be sent using AutoMail. 
 
To set up AutoMail for others, you must be an Administrator. 
 
Right-click on the TimeTiger icon, and hit the Explorer button. Then, select Tools - AutoMail... 
Click on the 'AutoMail for Others' tab. 
 
If you are using the sample database there will be an AutoMail entry already set-up for you. From 
this tab, you can Add, Edit or Delete AutoMails that have already been setup. 
 
Add a new AutoMail by clicking the Add button. The first thing you will need to do is select an 

Analysis that you wish to send to others. You will notice that only standard or previously saved 
analysis will appear in the list of available analyses (to add or edit the saved analysis types, see 
Saved Analysis).  
 
NOTE: It is recommended that you not send too many analysis types, or analysis types that are 
too complicated, as this might create lengthy emails or confuse your users. 
 
Next, select the Date Range that you wish to be included in the Analysis. The available ranges 
are: 
 
All  - this will include all time logs in the analysis each time it is sent. 
Today   - this will only show today's time entries (upto the time the AutoMail is sent). 
Yesterday - this will only show yesterday's time entries. 
Last 7 days - this will show the time entries for the last 7 days each time the AutoMail is sent. 
Last 30 days - this will show the time entries for the last 30 days each time the AutoMail is 
sent. 
Last 90 days - this will show the time entries for the last 90 days each time the AutoMail is 
sent. 
Last 365 days - this will show the time entries for the last 365 days each time the AutoMail is 
sent. 
Week to date - this will show entries for the curent week beginning Monday up until the current 
day. 
 
You can then choose to send AutoMail daily or weekly. 
 
The last question asks whether you want to show active data only, or active and inactive data. 
TimeTiger allows you to make Clients, Projects, tasks, categories, and users inactive when you 
edit their properties in the Explorer window. If you select active data only, your report will show 
only the active items. 
 
The next thing you will need to do is set-up the AutoMail recipient list. To do so, select the user or 
group from the list of Available Groups or Users and click on the Add button. You will notice that 
the user or group will move to the Selected Recipient list. You can remove recipients by clicking 
on the user or group in the Selected Recipient list and pressing the Remove button. To remove all 
recipients press the Clear button. 
 
Once you have created an AutoMail, you can also edit it. To Edit an AutoMail, select it in 
Tools...AutoMail and click on the Edit button or using the mouse, double-click on the row of the 
AutoMail you wish to edit. You can edit any of the AutoMail options described above. 
 
You may also delete an AutoMail from the list by highlighting the one you wish to delete and 
pressing the Delete button. 
 
To change addtional AutoMail Options, click on the Options tab. 
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5.5. Reminder E-mail 
 
AutoMail can also be used to send a reminder e-mail to users who log fewer than a defined 
number of hours in a week. You can use this option to encourage your users to diligently track 
their time usage. 
 
First, in Tools, Options, Field Names, rename one of the User custom fields to "Min Hrs." or 
something similar. This will be the field you use to store the minimum weekly hours per user. Use 
the TimeTiger Explorer to set the value of this field for each user to whom you will be sending 
reminders. 
 
In Tools, AutoMail, Reminder E-mail, check E-mail users who do not log enough hours each 
week. 
 
Select the user field you chose to hold minimum hours. 
 
If you wish to send a copy of each reminder e-mail to a particular e-mail address, for example, 
your TimeTiger administrator, you can enter that e-mail address in Copy all reminder e-mails to 
e-mail address. 
 
You can see what the reminder e-mail will look like in your inbox by clicking the Send test 
reminder e-mail button. 
 
Note: AutoMail Options must be configured in the Options tab in order to send reminder e-mails, 
and users must have both a valid number of minimum hours and a valid e-mail address in their 
Properties. 
 
Note: Reminder e-mails are sent on the same weekly schedule you define in AutoMail Options, 
and are sent for the previous complete week (typically Sunday through Saturday). 
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6. Administration 
 
6.1. Administration Overview 
 
All settings, general options, and information on various items in TimeTiger can be viewed or 
changed through the Explorer window. To get to this window, right-click on the icon in the system 
tray and click on the Explorer button. 
 
Although anyone can enter the TimeTiger explorer window and view information, only users with 
administrator access will be able to change the information that is there. 
 
If this is your first time using the Explorer, start at the section on Clients, Projects, and Tasks. 
  
  
  
 
6.2. Clients, Projects, and Tasks 
 
TimeTiger will allow you to create a list of Clients, Projects and Tasks. 
 
Note: You are required to create a full hierarchy for Projects when you are using TimeTiger. This 
means that you must have at least one Project for every Client, and at least one task for every 
Project. If your database is not set up for Clients or Tasks, that part of the hierarchy does not 
apply to you (TimeTiger allows you to customize the level of detail to better fit into your business 
process). You must also have at least one Category if your database is set up for categories. 
 
A Client refers to a particular customer that you might be doing work for. You can also treat 
internal departments as Clients if you wish. For example, if I wanted to use TimeTiger for internal 
tracking, each department would be a Client: 
 
Client: Marketing 
Project: Developing Balloons 
Task: Research 
 
Client: HR 
Project: Stocks 
Task: Documentation 
  
A Project refers to a specific Project that you might be working on for a Client. Each Client can 
have multiple Projects. 

A Task refers to a specific step within a Project that you could be working on. Each Project will 
likely have multiple tasks associated with it. 
 
Note: You may want to set up a Client with your own company name or as "internal" to capture 
time information about internal Projects. 
 
Another sample hierarchy could look like the following: 
 

Felware Minerals (Client) 
 Billing System (Project) 
  Initial Proposal (Task) 
  Design 
  Development 
  Testing 
  Rollout 
 Web Site Development (Project) 
  Initial Proposal (Task) 
  Design 
  User Testing 
  HTML programming 
  Testing 
  Rollout 
 
The tasks make up the steps that will be required to complete the Project. As you can see the 
Billing System Project and the Web Site Development Project have different tasks associated 
with them because different steps need to be taken to complete the Project. 
 
  
  
  
 

6.3. Categories 
 
TimeTiger allows you to track time not only through Clients, Projects and Tasks, but also through 
Categories. 
 
Categories represent groups of time which are spent in different Projects and that you would like 
to track. 
 
Examples 
Meetings, Travel, Training, Documentation, etc. 
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As you can see a category such as meetings might be used in many different Projects. So by 
setting up a meetings category, you can track how much time you are spending on meetings in all 
of your Projects, with all of your Clients. 
 
How do you choose which categories to create? 
 
Categories should be created when: 
You want to track where a particular type of time is being spent (e.g., writing proposals) 
You have a type of time which is common to a few Projects (e.g., meetings) 
 
Be careful to create categories which are as distinct from one another and whose meaning all the 
people using TimeTiger understand. The final point is very important because even if categories 
are clearly named, time can be allocated to them incorrectly if people are not trained properly on 
what should go in the categories. 
 
For example, 
 
Imagine that you have the categories, meetings and sales set up. Now one of your sales people 
goes out and meets with a Client. Should they mark their time under meetings, or under sales? 
 
It is important to clearly indicate to your people which one they should use and have them use it 
consistently for your analysis to be accurate. 
 
 
 
  
  
  
 

6.4. Groups and Users 
 
TimeTiger keeps track of all the users on the system. 
 
TimeTiger will allow you to create unique user names for each user on the system or it will use 
the names from the user ID on the network if you have that security option enabled. 
 
TimeTiger also gives you the ability to create groups for users. A User may only belong to a 
single group. Creating groups allows you to do reporting on a team and can be useful to find out 
how particular departments are spending their time. 
 
When you are creating users, you have the option of setting them as an Administrator or not. 
Administrators are the only users that can enter setup information into the database (such as new 
categories, Clients, Projects, tasks, users, etc.)  and change TimeTiger options. Administrators 

cannot change their status as an administrator or delete their user record - only other 
administrators can do that. 
 
Note: You can only have as many active users as you have licenses for TimeTiger. If you try to 
create an active user after you have used up your licenses, you will be asked to delete a user or 
mark someone as inactive. 
  
  
  
 
6.5. Cost Centers 
 
Allocation of time to different cost centers is handled using the "Category" field. Categories have 
a reference ID which can be used to hold the cost center ID. If your users know all their cost 
center codes, you can name the categories by cost center ID as well. If they don't, you can use 
the category names as a user-friendly way to select the cost center, and later do reporting on the 
cost center codes in the form of an Analysis that contains the Category Ref #. 
 
 
  
  
  
 
6.6. Using the Explorer 
 
Now that you know what all the items in the Explorer window are and how they should be used, 
you should review the section called Explorer-Overview. 
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7. Options 
 
7.1. Options Overview 
 
TimeTiger allows you to set various options in the following categories: Timers, Billing, AutoMail, 
Security, and Advanced. Note - only users that are set up as administrators can change options.  
 
To access the Options area, right-click on the TimeTiger Icon in your system tray. Click on the 
Explorer button, then choose Options from the Tools menu in the Explorer window. 
 
The Options area is divided into the following areas, which can be accessed by selecting the 
appropriate tab: 
 
• Timers 
• Billing 
• Security 
• Supervisor 
• Address 
• Field Names 
• Advanced 
 
When you are finished setting all your options, hit OK. 
  
  
  
 
7.2. Options-Timers 
 
To get to the Timers options, right-click on the TimeTiger icon, click the Explorer button, and 
select Options from the Tools menu. Choose the Timers tab. 
 
The Timers tab allows you to set the resolution of TimeTiger's timers, whether or not you track 
Overtime, and when the TimeTiger icon will flash red. You can also specify whether timer values 
should be rounded up or down to the nearest timer increment when you log your time. 
 
The resolution controls how often the timers increment, or "tick." For instance, if the resolution is 
set to "Every 15 mins. (1/4 hour)" then the timers would increment by 0.25 hours every fifteen 
minutes. 
 

The "round timer values up" checkbox controls whether timer values should be rounded up to the 
next increment when logging time. If this checkbox is not selected, the timer value will not "tick" 
until the full time period set through the timer resolution has elapsed. 
 
Checking "clear timers when TimeTiger is restarted" causes the QuickPick timers to reset to 0 
each time you exit and restart TimeTiger. This feature is useful if you shutdown your machine 
every evening. Note that if you check this option, your timers will not be protected if Windows  
hangs or your machine restarts unexpectedly: in this situation, your timers will be at 0 when 
TimeTiger is restarted. 
 
"Allow administratros to log and edit time for other users" allows TimeTiger administrators to log 
time for anyone in the system, and to edit anyone's time once it has been logged. 
 
"Allow time logging into the future" removes the restriction that time logs must be entered for the 
current date or prior days. If you check this option your users will be allowed to log time for future 
dates. 
 
By default, the Log Time window is automatically filled in with your non-blank QuickPick timers to 
speed time logging. The Status/Description field, however, is left blank to allow you to type in 
descriptive text for each activity. If you would like the Status/Description field to automatically 
default to the QuickPick timer's display name, check "Use timer display names as default log 
status/description." You will still have the opportunity to review and change this description. 
 
The Overtime checkboxes allow you to select whether you track overtime or not, as well as 
whether or not you want an additional Overtime item called "Extra Overtime." Extra Overtime is 
useful when you track things like overtime and double-time. You can use the Extra Overtime item 
to track your double-time. 
 
You also set billing rate factors for Overtime and Extra Time here. For example, if the Overtime 
factor is 1.5, then any Overtime lines on an invoice will be billed at 1.5 times your Rate for 
Regular hours. 
 
The flashing icon helps remind you to allocate your time. If this option is selected, TimeTiger's 
icon will flash red at you if you have not allocated time within the time period indicated in the box. 
  
  
  
 
7.3. Options-Billing & Taxes 
 
To get to the Billing options, right-click on the TimeTiger icon, click the Explorer button, and select 
Options from the Tools menu. There are two billing tabs in the Tools...Options. 
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Note: You can only do Client billing if your database is set up with Clients. 
 
Select Billing 1. The first question is whether or not you want to enable billing. If this box is not 
checked, you cannot create invoices, report on invoices, or set any other billing options. 
 
The next question asks if you do any Daily or Flat Rate billing. TimeTiger tracks time in hours, but 
you can also invoice Clients in Days, or at a Flat Rate. To enable Billing in Days, click that 
checkbox. To enable Flat Rate billing, click that check box. Each of these adds a button to the 
invoice edit screen to assist in creating that type of invoice. 
 
The last question on the Billing 1 tab lets you specify how the default billing rate for each time log 
entry should be determined. TimeTiger lets you specify a unique billing rate for every User, User 
Group, Client, Project, Task or Category you create in the Explorer screen. When creating 
invoices, TimeTiger looks at the User who created the log entry, the User Group to which they 
belong, and the Client, Project, Task, and Category to which the log entry has been assigned. 
The first non-zero billing rate found by TimeTiger is the one used on the invoice by default. You 
can control the order that TimeTiger looks through the log entry by using the Move Up and Move 
Down buttons on this screen. 
 
For example, lets suppose that JANE in the group DEVELOPMENT logged 1.0 hours to client 
ELIAS project NETWORK CONSULTING category CLIENT MEETING. JANE is billable at $50/hr. 
But this particular project, NETWORK CONSULTING, is billable at a reduced rate of $35/hr. The 
billing rates for DEVELOPMENT, ELIAS, and CLIENT MEETING are all set to $0. In the Billing 1 
tab, we move Client to the top of the list (as a preferred client rate takes precedence over any 
other rate), followed by Project and finally User. 
 
When an invoice is generated for this time log, TimeTiger will look at Client first. In this case, the 
rate for Elias is 0 (we have not specified a rate), so TimeTiger looks at the Project. The rate for 
the project is $35, so this is the rate used on the invoice by default. This rate can still be changed 
manually at invoice generation time.  
 
Select Billing 2. The first question is whether or not you want to print your company name on 
Invoices. If you print your invoices on letterhead, you may not want TimeTiger to print your 
address information. To enter your address information, click on the Address tab in 
Tools...Options. 
 
The next checkbox allows you to hide billing rate information from all non-administrative users. 
This is useful if billing rate information is confidential at your organization. 
 
The rest of Billing 2 is for setting up taxes. You can set up two different taxes inTimeTiger. For 
each, enter the name that should appear on the invoice, and the tax rate in percent. The "Tax 2 is 
charged on Tax 1" checkbox is for selecting whether or not Tax 2 is charged on Tax 1. For 
example, on line items where both taxes are charged, Tax 2 might be charged on the subtotal for 
the line after it has already had Tax 1 applied to it. 

 
As another example of using the two Taxes: In Ontario, Canada, there are two taxes - GST and 
PST. GST is 7% and PST is 8%. When both taxes are applied to something, they are individually 
charged on the subtotal. In this case, you would NOT check the "Tax 2 is charged on Tax 1" box. 
 
The last question asks which tax should be applied to all invoice lines by default. For example, in 
Ontario, Canada, time (or labor) charges must have GST applied to them, but not PST. In this 
case, you would select GST. Remember, this is just a default. When you are actually creating the 
invoice, you can still change the taxes applied to each line. 
 
Once everything is set up, you can start creating Invoices. 
  
  
  
 

7.4. Options-Security 
 
To get to the Security options, right-click on the TimeTiger icon, click the Explorer button, and 
select Options from the Tools menu. Choose the Security tab. 
 
TimeTiger allows you to select different ways for users to login. You have three choices: 
 
Always require username and password to enter TimeTiger 
If this option is selected, your users will have to enter their password every time they start 
TimeTiger. 
 
If user record exists in TimeTiger, bypass username and password window 
If this option is selected, and a person's username in TimeTiger is the same as their Windows 
username, TimeTiger will no longer ask for a password when the user starts TimeTiger. Security 
will be linked to the Windows login username and password. 
 
If user record does not exist in TimeTiger, create a default user record and permit login 
without password 
This will allow anyone who has never used TimeTiger to start using it without entering a 
password. A new user record will be added in TimeTiger the first time they start it up, and that 
record will appear in whatever group is selected in the box beside this option. 
 
Network Tip: If you need to go to each user machine to set up TimeTiger anyway, select the 
third option above before you do the other installs. This way, when you install TimeTiger on the 
other machines and run it for the first time, new user records will be entered with the Windows 
username of that person. Later, you can go back to this window and select the second option, 
securing TimeTiger with integrated password protection. 
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7.5. Options-Supervisor 
 
To get to the Supervisor options, right-click on the TimeTiger icon, click the Explorer button, and 
select Options from the Tools menu. Choose the Supervisor tab. 
 
The first choice you get is whether or not you want to enable supervisor approval. If this box is 
checked, then you can edit the other options. 
 
The next question is whether supervisors will be assigned to User Groups or to Projects. For 
example, if you want group leaders to approve time, then select "User Group." If you want Project 
leaders to approve time, then select "Project." 
 
The next question has to do with how often TimeTiger checks the database for denied time. 
TimeTiger will check the database for denied time, and notify you that your supervisor denied 
some of your time by flashing a red checkmark on your TimeTiger icon. In order to keep database 
activity lower (and improve the speed of TimeTiger), you are required to enter an interval of time 
during which it will perform this check. For example, if you enter 1 to 2 hours, it will check the 
database for denied time in random time increments from one to two hours. That way, everyone's 
computer isn't asking the database for this information at the same time. 
 
The last question has to do with how often a supervisor is reminded to review time for approval. 
This is how often TimeTiger will look for unreviewed time of the people they are supervising. If 
any exists, the TimeTiger icon will blink a red checkmark, reminding them to review that time. 
  
  
  
 
7.6. Options-Address 
 
To get to the Address option, right-click on the TimeTiger icon, click the Explorer button, and 
select Options from the Tools menu. Choose the Address tab. 
 
This is where your company name and address are stored. This information is used to put your 
company name on all reports, and to put your address on Invoices if you want to. To tell 
TimeTiger whether or not to put your address on an invoice, see the Options-Billing section. 
  
  
  
 

7.7. Options-Field Names 
 
To get to the Field Names options, right-click on the TimeTiger icon, click the Explorer button, and 
select Options from the Tools menu. Choose the Field Names tab. 
 
For each client, project, task, category, user and user group in TimeTiger, you can assign 
information to 3 custom fields that you can rename to suit your needs. In the Field Names tab of 
the Options screen, you can enter the field names you would like to use. 
 
If your database includes both Tasks and Categories, you can assign an optional Default 
Category for each Task. When the Task is selected, the corresponding default Category is 
automatically selected. Users can override this selection and pick a different Category unless you 
check the Do not allow users to override default category when logging time. When this 
option is checked, users cannot override the default Category selected when they choose a task. 
  
  
  
 
7.8. Options-Advanced 
 
This window allows you to set a number of advanced options. It is accessed via the Explorer 
window by selecting Tools...Options. 
 
The display extra warnings checkbox controls whether or not the following warnings are 
displayed to users: 
 
• When a user exits TimeTiger with time left to log. 
• When a user clears the main timer when it is not 0. 
• When the user designated as the AutoMail sender exits TimeTiger. 
 
The Canadian R&D tax credit information relates to R&D tax credits that Canadian companies 
can get for Scientific Research & Experimental Development. Companies who apply for this tax 
credit can use TimeTiger to aid in producing the required documentation when applying for a 
credit. By selecting this option, additional description fields with R&D questions appear in the 
Project properties (as viewed/edited from the Explorer window). These are the same questions as 
those in the Detailed Project Description section of Revenue Canada's T661(E) form. For more 
information, see the section called R&D-Overview. 
 
By default, TimeTiger will list projects and tasks sorted by their Estimated Start and Estimated 
End dates. Check sort projects and tasks alphabetically if you prefer an alphabetic listing. 
 
Use Safe Mode for Microsoft Access connections is a special option that helps prevent 
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database corruption of your TimeTiger database if your network is prone to occasional, temporary 
outages or failures. If you experience database corruption messages when using TimeTiger, try 
enabling this feature to see whether your problem goes away. Turning this feature on will slow 
down TimeTiger somewhat. 
 
The update interval sets how often you want each TimeTiger application (running on machines 
throughout the network) to download settings and options information from the TimeTiger 
database. Whenever you start TimeTiger, it checks to see which options or settings have 
changed and corrects them on the particular machine it is running on. Since most users leave 
TimeTiger running all day each copy of TimeTiger needs to check the database once in a while to 
see that no options have been changed (like the options you are changing in these windows). 
This option allows you to set how often the other copies of TimeTiger "check-in" to see what 
options have changed. The recommended range for this setting is 60-240 minutes, to help reduce 
database load. 
 
Rebuild MS Access security database is a button you should only need to use if advised to do 
so by Indigo technical support. This button will re-synchronize the security information in your 
Microsoft Access database file with the user names and passwords you have set up through 
TimeTiger. Note that you will need to re-activate TimeTiger/Web after rebuilding the security 
database if you use the TimeTiger/Web component. 
 
Activate TimeTiger/Web is a requirement for using TimeTiger/Web on a Microsoft Access 
TimeTiger database. You will need to select a password that you will then use when setting up an 
ODBC DSN entry for TimeTiger/Web as per the TimeTiger/Web installation instructions. If you 
forget the TimeTiger/Web password you select, you can reset it with this button. 
 
The "Compact TimeTiger Database" button is used to compact your Access database from time 
to time. As records are added and deleted from the database, free space is created within the 
database file. This button allows you to compact the database file to remove the excess free 
space, improving performance and decreasing the disk space required to hold your TimeTiger 
database. This option is not available for SQL Server databases. 
 
Tip: Compact your Access database regularly to keep it small and protect it from database 
corruption. Compact at least once per month, more often if you have over 10 TimeTiger users. 
 
The "Show Connected Users" button allows you to see who else has the Access database file 
open. You cannot compact your TimeTiger database with other users connected to it, so you can 
use this window to help track down those connections and close them. 
 
The "Use a different TimeTiger Database" button allows you to select another database to work 
with. If you hit this button, you will be asked to close TimeTiger and re-enter it, at which time you 
can select a database as explained in The First Time You Run TimeTiger. 
 
The "Enter New Authorization Key" button allows you to enter in a new authorization key, for 

instance if you purchased additional licenses. See the After the Setup Wizard section for more 
details. 
 
The "Backup TimeTiger Database" button allows you to copy your Access or SQL Server 
TimeTiger database to an Access-format TimeTiger database file. You can use this backup file 
for archival purposes. 
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8. Explorer 
 
8.1. Explorer Overview 
 
The Explorer is the main administration screen in TimeTiger. To get to the Explorer window, right-
click on the TimeTiger icon and select the Explorer button. The Explorer is used to add items 
such as Clients, Projects, Tasks, Users, and so on to the TimeTiger database. It is also the main 
access point for changing Options within TimeTiger, setting AutoMail options, generating reports 
using the Report Wizard, and creating or looking up Invoices. For information on what Clients, 
Projects, Tasks, Categories, etc. are and how they should be used, see the section on 
Administration. 
 
When an item is selected at the left of the window, the properties of that item appear on the right 
side of the window (where applicable). For instance, clicking on a user displays their name, when 
they were created, their user group, phone number, etc. You can also show the time logs related 
to that item by selecting View...Time Logs. To show properties again, choose View...Properties. 
 
Types of items are indicated in the list by a description and an icon beside the description. The 
types of items and their icons are: 
 
User groups  
Users   
Categories  
Clients   
Projects  
Tasks   
 
Note: The color of an icon changes if it is inactive. 
 
Administrators can add, change, and delete these items and their properties. Users who are not 
adminstrators have the following restrictions: 
 
• They can't add, delete, or change any items (Clients, Projects, Users, etc.) or their properties, 

except some of their own 
• They can't create, view, or delete invoices 
• They can't change general AutoMail options, but they can still change their own AutoMail 

options 
 
To add new items, select a similar item, go to the File menu, and choose New ... (where ... is the 
item you wish to create) or click on the New button on the toolbar: . You can also create new 

items by right-clicking on a similar item and selecting the appropriate New ... choice.  
 
To edit an existing item, select the item, go to the File menu, and choose Properties or click on 
the Properties button on the toolbar: . You can also edit items by right-clicking on them and 
selecting Properties from the menu. 
 
To delete an item, select the item and press the Delete key, or choose Delete from the Edit 
menu, or click on the Delete button on the toolbar: . 
 
To move an item, click on it with the mouse and hold the mouse button down while dragging it to 
the new location. 
 
To copy an item, click on it and choose Copy from the Edit menu, or click the Copy button on the 
toolbar: . 
 
To paste an item, click on the place where you want to paste it, and choose Paste from the Edit 
menu, or click on the Paste button on the toolbar: . 
 
The find an item by name, choose Find from the Edit menu. 
 
Note: You can only have as many active users as you have licenses for TimeTiger. If you try to 
create an active user after you have used up your licenses, you will be asked to delete a user or 
mark someone as inactive. 
 
  
  
  
 
8.2. Explorer-Item Properties 
 
For a detailed explaination of a particular item's properties, see the appropriate section below: 
 
User Groups 
Users 
Categories 
Clients 
Projects 
Tasks 
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8.3. Item Properties 
 
8.3.1. Properties-User Groups 
 
The following is a list of properties for User Groups and a description of each: 
 
Name - The name of the group. 
 
The Active option – This automatically defaults to checked; if this option isn't checked the group 
will not be allowed to enter the TimeTiger database. 
 
Billing Rates - You can enter default billing rates for this particular User Group, if you are using 
billing and if you bill different User Groups at different rates. 
 
Created On - The date on which the object was created. 
 
Reference # - The Ref # is a place where you can store a number or code for each group. 
 
The Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to 
store any other information you wish to keep track of for each group. 
 
The Description - A description of the User Group. 
  
  
  
 
8.3.2. Properties-Users 
 
When editing a user, you can change their properties, and also set a schedule for when the timer 
turns on and off for that user. For more information about the schedule, click here. 
 
The following is a list of properties for Users and a description of each: 
 
User Name - The system name for the user. 
 
Change Password - This button gives you the ability to enter or change a User's password. You 
simply click on this button and a screen pops up in which you type the password and then confirm 
it. When you hit OK, the new password will be verified, and if you didn't type the exact same 
password on both lines, you'll be told to re-enter the password. Otherwise, the password will 
change to the one you entered. 
 
The Active Checkbox - This automatically defaults to checked (active). If this box isn't checked 

the user will not be allowed to enter the TimeTiger database. 
 
Full Name- This is the full name of the user. 
 
Administration Checkbox - This marks the user as an administrator. Users who are not 
adminstrators have the following restrictions: 
• They can't add, delete, or change any items (Clients, Projects, Users, etc.) or their properties, 

except some of their own 
• They can't create, view, or delete invoices 
• They can't change general automail options, but they can still change their own automail 

options 
 
Billing Rates - You can enter default billing rates for this particular person, if you are using billing 
and if you bill different people at different rates. 
 
Created On - The date when the user was created. 
 
Telephone, Fax, Mobile, Pager - The person's phone numbers 
 
E-mail - Their email address 
 
Reference # - The Ref # is a place where you can store a number or code for each user. 
 
Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to store any 
other information you wish to keep track of for each user. 
 
The Description - A description of the User. 
 
Note: You can only have as many active users as you have licenses for TimeTiger. If you try to 
create an active user after you have used up your licenses, you will be asked to delete a user or 
mark someone as inactive. 
 
  
  
  
 
8.3.3. User Schedules 
 
You can set up a schedule for when the timers run for each user. For example, you can have the 
timers stop overnight when you are not at the office. 
 
To get to the schedule feature, right-click on the TimeTiger icon in your system tray. Click on the 
Explorer button. Open a user group and right-click on a user. Choose Properties. Now select the 
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Schedule tab. Turn on timer schedules by clicking the check box in the upper left area of this 
screen. 
 
By setting times in the boxes, you control when the timer will run. For example, if you set the 
timer on Monday to Start at 9:00 AM and end at 5:00 PM it will only run during those hours on 
Monday.  
 
Tips: 
 
• When entering times, use a 12 hour clock with AM or PM after the time.  
•If you leave the times as the defaults - 12:00 AM start and end - the timers will not run on those 
days. 
To change all weekdays to the same times, set up one of the weekdays to the hours you'd like. 
Then click on the All Weekdays button. 
  
  
  
 
8.3.4. Properties-Categories 
 
The following is a list of properties for Categories and a description of each: 
 
Category Name - The system name for the Category. 
 
The Active Checkbox - This automatically defaults to checked (active). If this box isn't checked 
the Category will not be available in the Log Time screen. In addition, information related to 
inactive Categories will not show up in reports unless a special option is flagged when the report 
is created. 
 
Billing Rates - You can enter default billing rates for this particular category, if you are using 
billing and if you bill different categories at different rates. 
 
Created On - The date when the Category was created. 
 
Reference # - The Ref # is a place where you can store a number or code for each Category. 
This is handy for things like cost center reporting. You can set up all your categories as cost 
centers, using the name as a text name of the cost center, and Ref # as the cost center code. 
This allows the users to read the text description of the cost center when they enter time, and 
allows you to do reporting on the codes later. 
 
Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to store any 
other information you wish to keep track of for each Category. 
 

The Description - A description of the Category. 
 
  
  
  
 
8.3.5. Properties-Clients 
 
The following is a list of properties for Clients and a description of each: 
 
Client Name - The name of the Client company. 
 
Change Password - This button gives administrators the ability to enter or change a Client's 
password. You simply click on this button and a screen pops up in which you type the password 
and then confirm it. When you hit OK, the new password will be verified, and if you didn't type the 
exact same password on both lines, you'll be told to re-enter the password. Otherwise, the 
password will change to the one you entered. 
 
The Active Checkbox - This automatically defaults to checked (active). If this box isn't checked 
the Client will not be available in the Log Time screen. In addition, information related to inactive 
Clients will not show up in reports unless a special option is flagged when the report is created. 
 
Contact Name- This is the contact person within the Client company. 
 
Created On - The date when the Client was created. 
 
Billing Terms - The default billing terms (e.g. Net 30) for the Client. 
 
Billing Rates - You can enter default billing rates for this particular category, if you are using 
billing and if you bill different Clients at different rates. 
 
Reference # - The Ref # is a place where you can store a number or code for each Client. 
 
Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to store any 
other information you wish to keep track of for each Client. 
 
The Description - A description of the Client. 
 
By Clicking on the Address Tab, you can access Address and Contact Information: 
 
Address - The Client's address. When an Invoice is created for this Client, the Bill to address will 
be a combination of the Client Name, the Contact name, and the address. 
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Telephone, Fax, Mobile, Pager - The contact person's phone numbers. 
 
E-mail - Their email address. 
 
URL - Their web site address. 
  
  
  
 
8.3.6. Properties-Projects 
 
In addition to ordinary properties for a particular Project, TimeTiger can track R&D information 
about the Project. If the option to track R&D information is enabled, you will see five tabs behind 
the Project properties that hold the answers to the five questions on the Revenue Canada T661 
(E) form for requesting Tax Credits. For more information, see the section R&D-Overview.  
 
The following is a list of properties for Projects and a description of each: 
 
Name - The name of the Project. 
 
The Active Checkbox - This automatically defaults to checked (active). If this box isn't checked 
the Project will not be available in the Log Time screen. In addition, information related to inactive 
Projects will not show up in reports unless a special option is flagged when the report is created. 
 
MS Project File - If you are already using MS Project to track your Projects, you can import tasks 
from the MS Project file to TimeTiger. This spot stores the location and name of the MS Project 
file. For more information on how to import tasks, see the section on Importing Tasks. 
 
Created On - The date on which the object was created. 
 
Estimated Start Date - The date you expect to start the Project. This is useful later for 
performance analysis. You can either type in the date, or choose it from the calendar by pressing 
the ... button. 
 
Estimated Finish Date - The date you expect to finish the Project. You can either type in the date, 
or choose it from the calendar by pressing the ... button. 
 
Estimated Hours - The number of hours you expect the Project to take. 
 
Billing Rates - You can enter default billing rates for this particular Project, if you are using billing 
and if you bill different Projects at different rates. 
 
Reference # - The Ref # is a place where you can store a number or code for each Project. 

 
The Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to 
store any other information you wish to keep track of for each Project. 
 
The Description - A description of the Project. 
  
  
  
 
8.3.7. Properties-Tasks 
 
The following is a list of properties for Tasks and a description of each: 
 
Task Name - The name of the Task. 
 
Priority - Allows you to show different priorities for different tasks. 
 
The Active Checkbox - This automatically defaults to checked (active). If this box isn't checked 
the Task will not be available in the Log Time screen. In addition, information related to inactive 
Tasks will not show up in reports unless a special option is flagged when the report is created. 
 
Created On - The date on which the object was created. 
 
Estimated Start Date - The date you expect to start the Task. This is useful later for performance 
analysis. You can either type in the date, or choose it from the calendar by pressing the ... button. 
 
Estimated Finish Date - The date you expect to finish the Task. You can either type in the date, or 
choose it from the calendar by pressing the ... button. 
 
Estimated Hours - The number of hours you expect the Task to take. 
 
Default Category - To help insure that users enter categories consistently when logging their time, 
you can assign a default category to automatically appear in the Time Log window when a user 
chooses this task. 
 
Billing Rates - You can enter default billing rates for this particular Task, if you are using billing 
and if you bill different Tasks at different rates. 
 
Reference # - The Ref # is a place where you can store a number or code for each Task. 
 
The Custom Fields 1-3 - The Custom fields (Custom 1, Custom 2, Custom 3) can be used to 
store any other information you wish to keep track of for each Task. 
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The Description - A description of the Task. 
 
Do Not Update MS Project checkbox - Check this box if you are synchronizing this task with a 
Microsoft Project file but do not wish the TimeTiger time logged to be exported back to the 
Microsoft Project file. 
  
  
  
 
8.4. Explorer-See Timers 
 
You can quickly create similar QuickPick timers for a group of users by copying some or all of one 
user's QuickPick timers to another user. For example, if several of your users need the same 
QuickPick timers, you can create them for one user and then copy them to the other users in the 
group. 
 
First, create a set of QuickPick timers for one user. Then, right-click on that user in the TimeTiger 
Explorer and choose See Timers... Note that you must be logged in as a TimeTiger administrator 
to see this option. 
 
You will see a list of the user's QuickPick timers. Check the timers you wish to copy. Then choose 
the user you wish to copy the timers to. Click the Copy Now button to start the copy. Repeat this 
step for each user that needs the same list of QuickPick timers. 
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9. Importing from MS Project 
 
9.1. Import Overview 
 
TimeTiger allows you to work with Microsoft Project and helps keep track of how much time is 
being spent on your Projects. It does this by importing Tasks from your MS Project file, and 
exporting time worked information. 
 
By periodically importing your MS Project file into TimeTiger, and exporting time worked, you can 
use TimeTiger to track the actual time spent on your projects, and have your MS Project file 
accurately reflect this information. 
 
Note: 
In order to use the tasks from Microsoft Project you must first ensure that your TimeTiger 
database supports tasks. See the section on Time Groupings for more details. If you have not 
created a TimeTiger database which allows tasks then you must create a new one if you would 
like to use this feature. 
 
You must also have MS Project 4.1 or greater installed on the machine where you are doing the 
import. 
 
Importing a Microsoft Project File 
• Right-click on your TimeTiger icon 
• Hit the Explorer button to go to the explorer screen 
• Select the Project that you would like to add tasks for (you need to create the Project in 

TimeTiger before importing a Microsoft Project file). 
• Edit the properties of the Project - See Item Properties for details 
• The first line will contain the name of the Project and the 2nd line will ask you for an MS Project 

file name. Click on the Import button to bring up the Project Import Wizard 
 
See the File Location section to continue. 
 
The following fields are imported for the Project: 
 
From Microsoft Project: Into TimeTiger project: 
Start Date Estimated Start Date 
Finish Date Esitmated End Date 
Planned Hours of Work Estimated Hours 
Notes Description 
 

The following fields are imported for each Task in the Project: 
 
From Microsoft Project: Into TimeTiger task: 
Task Name Task Name 
Priority Priority 
Start Date Estimated Start Date 
Finish Date Estimated End Date 
Planned Hours of Work Estimated Hours 
Notes Description 
WBS WBS Code 
 
The following fields can optionally be exported back into the MS Project file for each Task: 
 
From TimeTiger task: Into Microsoft Project: 
Actual Hours of Work Actual Hours of Work 
Actual/Estimated Hours * 100 Percent Complete 
 
  
  
  
 
9.2. Import Wizard-File Location 
 
On the Project File Location screen, enter the location of the Project file which you would like to 
take tasks from. You can also hit the Browse button to search for the Project file. 
 
Once you click on the Next button, TimeTiger will begin reading the Project file. Please be patient 
as this can take several minutes in the case of large files. 
 
See the New Tasks section to continue once the file has been read. 
  
  
  
 
9.3. Import Wizard-New Tasks 
 
The New Tasks step shows you a list of tasks that TimeTiger will add from your Microsoft Project 
file. TimeTiger will also update any tasks you have previously imported, but will not delete any 
tasks that are no longer present in the MS Project file. So, if you remove tasks from MS Project, 
you need to manually remove them from TimeTiger as well. 
 
At this step, you can adjust the level of the tasks that you would like to import from MS Project. 
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You can select from 1 level to 10 levels of Tasks and Subtasks to import. The maximum (10 
levels) is the default. 
 
The next step is Import Options. 
  
  
  
 
9.4. Import Wizard-Options 
 
In this step, you can specify whether TimeTiger should export time worked and percentage 
complete information back into the MS Project file. Click the Yes checkbox if you want this 
information to be exported. 
 
You can also specify the method TimeTiger uses to calculate the Percent Complete field in 
Microsoft Project. Select "Actual hours logged vs. Task Duration" to send the actual time you 
entered in TimeTiger back into Microsoft Project as Actual Work. This will set the Percent 
Complete to accurately reflect the actual work vs. your original estimated work. 
 
Alternately, you can directly specify the % complete of each task by using one of the TimeTiger 
custom fields in the Task Properties. Select "From a field in the TimeTiger Task Properties" to 
use a custom field to specify % complete. Then, for each task in the project, enter the % complete 
into the custom field of your choice. The % complete must be entered as a number from 0 to 100, 
and you should not enter the % mark itself: simply the number. Note that if you choose to directly 
enter the % complete, the actual worked information will not be transferred to Microsoft Project: 
only the % complete will be transferred. 
 
Click Finish to proceed with the import/export of the MS Project file. 
 
Note: 
If you have chosen to add some new tasks to TimeTiger, you must click OK in the Project window 
in order for the new tasks to be added. If you click Cancel, the new tasks will not be added and 
you will need to run the Import Wizard again. 
 
If you change your MS Project file at a later date (by adding new tasks, for example), you should 
update TimeTiger by running the Import Wizard again. See Updating TimeTiger for details. 
  
  
  
 

9.5. Updating TimeTiger 
 
Once the intial import of tasks from a MS Project file has been completed, it may be necessary to 
update TimeTiger with more current information or changes in the MS Project file. 
 
To accomplish this, simply run through the import procedure as you would if you were importing 
tasks for the first time.  
 
There is a subtle difference though, the New Tasks screen on the Import Wizard will only display 
new tasks that have been added since the last time an import from this MS Project file had been 
done. 
 
When you start importing, TimeTiger will not only add these new tasks to the database, but it will 
automatically update any changes to the start and finish dates, the priority, and the task notes of 
the tasks that you imported before. 
 
Note that even if you rename the task within TimeTiger and do an update from Project, TimeTiger 
will know what the original task name was and be able to update the task. 
 
Example, 
 
• You have a task in MS Project called Initial Prototype Design. 
• You rename it in TimeTiger to Proto. Design. 
• You change the timeline for the task in MS Project. 
If you update the Project in TimeTiger, the timeline for Proto. Design will be updated even thought 
the task names are different in TimeTiger and MS Project. 
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10. Supervisor Approval 
 
10.1. Approval Overview 
 
TimeTiger allows you to require supervisor approval for any time that will appear on reports or 
invoices. This can be used as a second check on all user time by a supervisor for spelling errors, 
improper language, etc. 
 
When Supervisor Approval is turned on, time is entered as usual by regular users. After a pre-
defined period of time, a supervisor's TimeTiger icon will start to flash with a small checkmark on 
it. This indicates to the supervisor that they must approve someone's time. The supervisor goes 
into the Edit Time window and reviews the time logs for all users that they are responsible for. 
They can approve or deny individual entries or a group of entries. When they deny time, they are 
asked to enter a description as to why the time was denied. When approving time, the colors of 
the log entries changes according to what you change. Below is a list of the colors and what they 
mean: 
 
• White - Normal time log entries that have not been reviewed by a supervisor 
• Red - Denied time log entries - when you click on these, a note will appear at the bottom of the 

screen telling you why the entry was Denied 
• Green - Time that has been approved by your supervisor 
• Grey - Time that appears on an invoice - it cannot be edited anymore 
 
When the user logs on to TimeTiger and their supervisor has denied some time logs, that user's 
TimeTiger icon will flash with a check mark indicating that they must review their time and correct 
denied time logs. 
 
For information on how to set up your database for supervisor approvals, see the section called 
Approval-Setup. For information on approving time, see the section called Approval-Approving 
Time Logs. For information on denied time, see the section called Approval-Editing Denied Time. 
 
 
  
  
  
 
10.2. Approval-Setup 
 
To enable supervisor approvals in your database, right-click on the TimeTiger icon and click on 

the Explorer button. Then, select Tools...Options. Click on the Supervisor tab. This is where you 
can enable and change options related to supervisor approval. For details on what these options 
mean, see the Options-Supervisor section. 
  
  
  
 
10.3. Approval-Assigning Supervisors 
 
A supervisor can be assigned to a User Group or a Project. To select whether supervisors are 
assigned to User Groups or to Projects, go to the Supervisor tab in Tools...Options. 
 
To assign a supervisor, right-click on the TimeTiger icon. Click on the Explorer button. Select the 
User Group or Project for which you wish to assign a supervisor. Right click on the item and 
choose Properties. Select the supervisor from the list presented beside "Supervisor." For more 
information on working with item properties, see the Explorer-Item Properties section. 
 
Note: Supervisors can have supervisors. To do this, enable supervisor approval by UserGroup. 
Create a group called "Management."  Put your first supervisor in there. Assign them to whatever 
other group you want them to supervise. Now, create a third group called Directors. Put someone 
in their - they can supervise the "Management" group. Now you have a supervisor hierarchy. 
Change group names accordingly. 
  
  
  
 
10.4. Approval-Approving Time Logs 
 
TimeTiger tells you that you need to review people's time logs on a periodic basis. To change that 
period, read the section on Options-Supervisor. When a supervisor is required to review time 
logs, their TimeTiger icon will blink with a red check mark. The Edit Time button on their 
QuickPick window will also flash. 
 
You can also check if you have time that is unreviewed by right-clicking on the TimeTiger icon 
and hitting the Check for Time Logs button. If you have any time to review, your TimeTiger icon 
will blink the checkmark and the Edit Time button will also flash. 
 
To review time logs, right-click on the TimeTiger icon and hit the Edit Time Logs button. You will 
be presented with your time logs, and a list of User Groups or Projects that you are the supervisor 
of. You can select individual Users or Projects, and see the time logs associated with that User or 
Project. The logs will be different colors depending on thier status. A list of colors and their 
meanings appears below: 
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• White - Normal time log entries that have not been reviewed by a supervisor 
• Red - Denied time log entries - when you click on these, a note will appear at the bottom of the 

screen telling you why the entry was Denied 
• Green - Time that has been approved by a supervisor 
• Grey - Time that appears on an invoice - it cannot be edited anymore 
 
When you first enable supervisor approvals, all time logs will be marked as approved (green). 
 
You can restrict the tree view at the left of the screen to show only the Users and Projects that 
have time that needs to be approved. To do this, enable the "Only users (Projects) to approve" 
checkbox. 
 
You can sort the time logs in different ways by choosing an option from the "Sort" box at the top 
of the screen. You can also show only Approved, Denied, or Not Reviewed time by choosing an 
option from the "Show" box at the top of the screen. 
 
Select entries with the mouse. To select more than one entry, click on the first one, then hold 
down the shift key and click on the last one. To select all entries, click on the "All" button. 
 
You can either approve or deny the selected entries. To approve them, click on the checkmark 
button: . They will turn green. To deny them, click on the NO button: . You will be asked for 
an explanation for the denial. This explanation will appear at the bottom of the screen when the 
denied entry is selected. If you deny several entries at the same time, your description gets 
attached to each of the entries. 
 
If you want to change time back to unreviewed time, click the Unreview button: . To delete an 
entry, select it and click the delete button: .  
 
Note: Generally you should not delete entries for people reporting to you. Rather, deny the entry 
and give them a chance to respond or delete it themselves. 
  
  
  
 
10.5. Approval-Editing Denied Time 
 
Once a supervisor has denied your time, your TimeTiger icon will blink with a red checkmark. 
Right-click on the TimeTiger icon, and click the Edit Time Logs button. You will be presented with 
your denied time. Those denied entries will show up in red in the edit screen. The following is a 
list of the colours of Time Logs and what they mean: 
 
• White - Normal time log entries that have not been reviewed by a supervisor 

• Red - Denied time log entries - when you click on these, a note will appear at the bottom of the 
screen telling you why the entry was Denied 

• Green - Time that has been approved by a supervisor 
• Grey - Time that appears on an invoice - it cannot be edited anymore 
 
As stated above, Clicking on a denied entry will show a note at the bottom of the screen saying 
why your supervisor denied the time. Correct the entry. As soon as you edit anything, the entry 
will turn white again, signaling that the time is unreviewed. The note will also disappear. 
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11. Invoices 
 
11.1. Invoices Overview 
 
TimeTiger allows you to create invoices from your time data. You can create invoices based on 
the exact number of hours you worked on a Project, on the number of days that you worked on a 
Project, or on a flat rate. 
 
Note: TimeTiger can handle different invoice types and different taxes. It can save invoices, and 
print them. One thing TimeTiger doesn't do is track receivables. It is assumed that you will track 
your company's financial data elsewhere, and that you will generally use TimeTiger to create and 
print your time-related invoices. 
 
To be able to create and track invoices in TimeTiger, your database must support Clients. If you 
cannot add or edit Clients in the Explorer view, you are not set up for Clients and will have to set 
up a new database that contains Clients. See your system administrator for assistance. 
 
If you are set up for Clients, the first thing  you must do is enable Billing and set up Taxes for your 
company. To set these up, go to Options-Billing & Taxes. 
 
Once Billing and Taxes are set up, You can create individual invoices by right-clicking on the 
TimeTiger icon, hitting the Explorer button, and choosing File...Create Invoice from the Explorer 
screen. This will bring you to the Invoice Edit Screen. 
 
You can create batches of invoices by right-clicking on the TimeTiger icon, hitting the Exporer 
button, and choosing File...Invoice Wizard. This will start the Invoice Wizard. The Invoice Wizard 
can create many invoices at once. 
 
 
  
  
  
 
11.2. Invoice Edit Screen 
 
The Invoice Edit Screen is accessed by selecting File...Create Invoice from the Explorer window. 
 
Once you're in the Invoice Edit Screen, select the Client you wish to invoice. Select the Project 
you are invoicing for. At this point, TimeTiger will fill in all the time entries related to that Project 
since the last invoice for that Project (everything that hasn't been billed yet). It will also fill in an 

invoice number, the Client address, the terms associated with that Client, and today's date. If you 
set the invoice date to an earlier date, TimeTiger will remove those entries which occurred after 
the invoice date. For example, if it's May 4 and you invoice for April 30, Time Logs from May 1 to 
May 4 will no longer appear (once you save the invoice, this no longer happens if you change the 
date). 
 
NOTE: If you have supervisor approvals enabled, only approved time logs will appear on the 
invoice. For more information on Supervisor Approval, see that section. 
 
Taxes for each line item will also be filled in. You should notice that the Total (at the bottom of the 
screen) = SubTotal + Taxes. To see the tax amounts, hit the Print button , which will bring you 
to the invoice view screen. For more information on viewing and printing invoices, see the Printing 
Invoices section. 
 
At this point, you can fill in a Purchase Order (P/O) Number, A Rep at your company for the 
Project, and a Client Note that will appear on the invoice. Note - the Client Note will automatically 
fill in with the last Client Note you used on an invoice. You can also edit the Bill To address, 
invoice number, and terms. 
 
If you want to add a note to yourself about this invoice, click on the "Notes" tab at the top of the 
screen. To return to the invoice, click on the "Invoice" tab. 
 
After all the invoice header information is entered, you can make changes to the Line Detail 
Information. 
 
Note: if you have Daily and/or Flat Rate billing enabled, you will one or both of the following 
buttons in the Header area of the Invoice: "Bill at Flat Rate" or "Bill in Days." Usage of these 
buttons is covered in the sections Flat Rate Invoices and Billing in Days, respectively. 
 
Tip: If you are required to show a registration number such as the GST Registration number (in 
Ontario) on every invoice, a good place to put it is in the Customer Message. The Customer 
Message gets remembered from invoice to invoice, and so will your registration number. 
  
  
  
 
11.3. Line Detail Information 
 
Each of the lines in the invoice can be changed from what was previously entered into TimeTiger. 
In the left portion of the screen, you see the information that will appear on the invoice. On the 
right portion of the screen, you see information from TimeTiger's Time Logs that does not appear 
on the invoice. You can move the bar between these two screen sections if you want to see more 
of one or the other. 
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The Date for each line item is the Date the entry was recorded in TimeTiger. This date will appear 
beside the line item on the invoice. 
 
The Description is the description as entered, and will also appear on the invoice. 
 
The Qty will initially correspond to the number of hours that were entered for that Time Log in 
TimeTiger. You can change this quantity without changing the hours shown on reports, etc. in 
TimeTiger. 
 
The Unit is the Unit you will bill in. The different Units available in TimeTiger are: 
 
• Regular Hrs. - for invoicing the hours you spent on this item 
• Overtime Hrs. - for invoicing at your Overtime rate, if you have Overtime set up 
• Extra Hrs. - for invoicing at your Extra Time rate, if you have Extra Time set up 
• Days - for invoicing that particular line in Days instead of hours. You will need to change the 

Rate and Qty if you change this to date. If you want to bill all entries as Days, you should set 
that option up and use the Bill in Days button. 

• Flat Rate - Used to create a Flat Rate line on an invoice. Usually this is only used for the one 
line that contains the entire flat rate, and the rest of the invoice lines are marked as their 
original Unit or Do Not Show. If you want to create a Flat Rate invoice, you should set that 
option up and use the Bill at Flat Rate button. 

• Do Not Show - If you select this Unit, the line will not show up on the invoice. The line will also 
turn grey to indicate that it will not show up on the invoice. 

• Other - This is used if you want to mark a line with a Unit other than one of the Units above. 
Note - for reporting on performance (e.g. Hrs. worked vs. Total charged), the "Other" lines are 
not counted in the Total charged. 

 
The Rate is the rate to be charged to each line on the invoice. Normally, these rates are set by 
default to the rates filled out in Item Properties, and selected in Tools...Options...Billing. 
 
The Tax is the tax that will be applied to each line on the invoice. Normally, this defaults to the tax 
set up in Tools...Options...Billing. 
 
To Add a line, click on the Add Line button at the bottom of the screen. You will be asked to fill in 
all the properties for that line. This button is useful to add items such as equipment to an invoice, 
or to add a Discount line. These lines normally have the "Other" Unit assigned to them. 
 
To delete an entry, select it and then hit the delete key on the keyboard. 
 
When you are finished setting all your invoice details, you can save the invoice by clicking the 
save button: .  
 

Note: As soon as you save an invoice, all line items related to that invoice will turn grey in any 
edit screen, and you will not be able to edit them. 
 
To view, then print the invoice, click the print button: . See Printing Invoices for details. 
  
  
  
 
11.4. Flat Rate Invoices 
 
If you want to bill Flat Rate instead hourly, you should enable Flat Rate billing in 
Tools...Options...Billing. Then, create an invoice and fill in the header information as explained in 
the Invoice Edit Screen section. 
 
Now hit the "Bill at Flat Rate" button. the Add Invoice Line window will appear. 
 
• Enter the date for the line.  
• Enter a description (e.g. "Project Flat Rate - 40% of Project total").  
• Enter a Qty - usually this would be 1, and then you'd put your Flat rate price in under Rate. If, 

however, you are billing a flat rate of units of time, you might want to enter the number of units, 
and then the rate per unit. The subtotal shows Qty*Rate. 

• Select the taxes that should be applied to this line. 
• Finally, indicate whether or not you want to show the detail lines on the invoice. If so, they will 

all be listed, but with a Rate of $0.00. If not, they will all be shaded in grey, and will have "Do 
not Show" as their Unit. 

 
You can now add other lines as explained in Line Detail Information. 
 
Save the invoice by hitting the Save button: . 
 
Note: As soon as you save an invoice, all line items related to that invoice will turn grey in any 
edit screen, and you will not be able to edit them. 
 
When you are ready, you can view and print the invoice as explained in Printing Invoices. 
  
  
  
 
11.5. Billing in Days 
 
If you want to bill Daily instead hourly, you should enable Billing in Days in 
Tools...Options...Billing. Then, create an invoice and fill in the header information as explained in 



TimeTiger 1 
 

 Page 36

the Invoice Edit Screen section. 
 
Now hit the "Bill in Days" button. The first line of each day (as you go down the page) will change 
to a "Day" line. All others will turn grey and become "Do not Show" lines. 
 
For each "Day" line (the first one each day), the Unit will change to Days. The Rate will change to 
the default Day Rate entered in Item Properties, and selected in Tools...Options...Billing. The Qty 
will change to 1.0 (1.0 Days).  
 
You should now edit each day line to reflect the work done that day. 
 
When you are finished, you can add other lines as explained in Line Detail Information. 
 
Save the invoice by hitting the Save button: . 
 
Note: As soon as you save an invoice, all line items related to that invoice will turn grey in any 
edit screen, and you will not be able to edit them. 
 
When you are ready, you can view and print the invoice as explained in Printing Invoices. 
 
  
  
  
 
11.6. Printing Invoices 
 
The report you edited will be displayed in your default web browser. You must either print the 
invoice from your web browser or, if you have Microsoft Excel installed, open the file using 
Microsoft Excel. In Microsoft Internet Explorer, this is as easy as choosing the "Edit with Microsoft 
Excel" option from the browser's file menu. With other browsers, you may need to Save the 
HTML file to your hard disk and open it from Microsoft Excel. 
 
When printing TimeTiger invoices, you may need to adjust the paper orientation and margins to 
make your invoice appear properly on the page. Feel free to experiment with the layout options 
available in your web browser and in Microsoft Excel to make the invoice look just as you want it. 
 
After printing an invoice, close this window. Later, you can always get the invoice back and re-
print it by Looking up Previous Invoices. 
 
 
  
  
  

 
11.7. Looking up Previous Invoices 
 
After having created invoices, you can always look them up later to view, edit, or delete them. To 
get to the Invoice lookup screen, right-click on the TimeTiger icon, hit the Explorer button, and 
choose Lookup Invoice. 
 
Select the Client that the invoice was for. A list of all invoices for that Client will appear. 
 
Choose the View button to view or edit the invoice. This will take you to the Invoice Edit screen. 
From there you can make changes and/or print the invoice again. 
 
Choose the delete button to delete a report. 
 
Choose the Close button to exit the screen and return to TimeTiger Explorer. 
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12. Invoice Wizard 
 
12.1. Invoice Wizard Overview 
 
The Invoice Wizard allows you to create many invoices at once. This can be extremely useful if 
you periodically bill all your clients (once a month, for example) and would like to create and print 
all the invoices in one step. 
 
Using the Invoice Wizard 
• Right-click on your TimeTiger icon 
• Hit the Explorer button to go to the explorer screen 
• Choose Invoice Wizard from the File menu 
 
The first step in the Invoice Wizard is Select Invoice Date. 
 
Note: 
the Invoice Wizard can only create Hourly invoices. If you want to create Flat Rate or Daily 
invoices, you must create each invoice individually by using the Invoice Edit Screen. 
 
For more information about creating invoices, see Invoices Overview. 
  
  
  
 
12.2. Invoice Wizard-Select Invoice Date 
 
Pick the invoice date for all the invoices you wish to create. Time entries that were logged on or 
before that invoice date, and that do not already appear on another invoice, will appear on the 
invoice. 
 
Click Next to go to the next step, Select Invoices to Create. 
  
  
  
 
12.3. Invoice Wizard-Select Invoices to Create 
 
Here you see a list of all the invoices that could be created by TimeTiger. For each invoice, you 
see the client, project, and number of hours of time that would appear. You also see the invoice 

date for the most recent invoice created for that project, if any. 
 
You can review this list and uncheck any invoices that you do not wish to create at this time. Click 
All to check all the invoices, or None to uncheck them. 
 
When done, click Next to go to the Options step. 
  
  
  
 
12.4. Invoice Wizard-Options 
 
At this step, you can select a number of options for invoice generation. 
 
Starting invoice number is the number of the first invoice that is generated. Subsequent 
invoices will be numbered consecutively. 
 
Client Note is a short message that will appear at the bottom of each invoice. For example, 
"Thank you for your business." 
 
Print invoices after they are created should be checked if you want to print your invoices. 
Invoices will be created and printed through your system's default web browser, which may pop 
up a Print dialog-box before each invoice you print. 
 
Click Finish to generate, and optionally print, your invoices. 
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13. Frequently Asked Questions 
 
13.1. FAQ Overview 
 
The following are Frequently Asked Questions about TimeTiger that are answered in this Help 
File. For a more up-to-date list of Frequently Asked Questions, go to the TimeTiger web site at 
http://www.timetiger.com. 
 
• Why is my TimeTiger icon blinking? 
• What if I've been away for more than a day, and need to allocate time to those days? 
• Can I use TimeTiger on my laptop when I'm not at the office? 
• What if my computer crashes and I didn't allocate time? 
• Do I always have to have TimeTiger running when I want to track my time? 
• Why is TimeTiger telling me it cannot connect to the database? 
• I forgot to allocate time for something, and now my Timer shows 0.0 
• TimeTiger is Telling me I don't have enough licenses - What now? 
• Why don't taxes show up on my Invoice? 
• Why do lines on my invoice turn grey? 
• What do the line colors mean in Edit Time? 
• Can I remove the login security? 
• Why aren't the timers changing? 
• Why can't I edit Clients, Projects, etc.? 
• Why can't I change Tools...Options? 
• If I'm a Supervisor, how do I edit my own time? 
Why don't some of my users show up in an analysis? 
  
  
  
 
13.2. Why is my TimeTiger icon blinking? 
 
TimeTiger has a built in reminder mechanism. The TimeTiger icon will begin blinking red  after 
a pre-defined number of hours has passed since the last time you entered your time. The default 
is that it blinks after two hours. You can change how soon after your last allocation the icon starts 
blinking by going into Tools...Options in the Explorer window. 
 
To ensure that you are accurately entering your time, you should try and allocate your time as 
frequently as possible, ideally, every time you switch tasks or Projects. 

 
If you are a supervisor, and you need to review time, the icon will blink with a small checkmark 

. You will also get this icon flashing if you have a supervisor, and some of your time has been 
denied. To learn about supervisor approvals and correcting your denied time, see Supervisor 
Approval. 
 
  
  
  
 
13.3. What if I've been away for more than a day, and need to 
allocate time to those days? 
 
To help speed up the time it takes you to regularly enter time, the TimeTiger Log Time window 
defaults to the current date. If you want to allocate time for dates in the past, you can. 
 
At the top left corner of Log Time window you will notice an area that contains the date. To enter 
time for dates in the past: 
 
• Enter the date for which you want to allocate time in the date field. 
OR 
• Click the button to the right of the Date field and select the date from the calendar that appears. 
 
Once you've entered the date for which you want to allocate time, just enter your time as usual. 
See Log Time Overview for more details. 
  
 
  
  
  
 

13.4. Can I use TimeTiger on my laptop when I'm not at the 
office? 
 
TimeTiger does not support laptop synchronization. You could install TimeTiger on your laptop, 
but you would not be able to link your time data to that of others at your company. Please check 
our web site at http://www.timetiger.com to find out about TimeTiger/Web and future versions of 
TimeTiger, which give you time logging options while on the road. 
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13.5. What if my computer crashes and I didn't allocate time? 
 
The TimeTiger main timer is continually running even when your computer is off. So if your 
computer crashes or there's a power failure and you didn't allocate time, don't worry. When you 
re-start TimeTiger you'll find that the timer will have continued to track your time (even while your 
computer was down) and you can enter your time where you left off.  
  
  
  
 
13.6. Do I always have to have TimeTiger running when I 
want to track my time? 
 
The TimeTiger timers are continually running even when the program is not or your computer is 
off. Each time you launch TimeTiger you will notice that the program has kept timing since the 
last time you entered your time. 
  
  
  
 
13.7. Why is TimeTiger telling me it cannot connect to the 
database? 
 
Database connection problems can occur for any of the following reasons: 
 
• The database has been moved from its original location. 
• Your computer is not connected to your network or you are not logged in. 
• Your network administrator has not allowed you sufficient privileges to your network login 

account. 
• TimeTiger has not been correctly set up on your computer. 
 
For help diagnosing and solving your problem, visit the TimeTiger web site, www.timetiger.com 
  
  
  
 

13.8. I forgot to allocate time for something, and now my 
Timer shows 0.0 
 
TimeTiger allows you to allocate more time than what is showing on the timers. Right-click on the 
timer and click Set Time To. Type in the time you spent on the task (for example, 1.5) and click 
OK. 
  
  
  
 
13.9. TimeTiger is telling me I don't have enough licenses - 
What now? 
 
If you do not have enough licenses to add an additional user, you need to delete or de-activate a 
user (see Explorer section). If you would like to have more active users, you need to purchase 
additional licenses from Indigo Technologies Ltd. E-mail Indigo at info@indigo1.com for 
purchasing details and pricing. 
  
  
  
 
13.10. Why don't taxes show up on my invoice? 
 
If taxes are not showing up on your invoice, they are either not set up, or the default tax for each 
line item is not set. See the section on Options-Billing for information on how to set up your taxes. 
  
  
  
 
13.11. Why do lines on my invoice turn grey? 
 
When you mark a line as a Day item, or when you create an invoice and hit the Bill in Days 
button, only the first line of each day appears white. the rest of the lines appear grey, and will not 
be printed on the invoice. For more information, see the section on Billing in Days. 
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13.12. What do the line colours mean in Edit Time? 
 
If supervisor approvals are enabled, different lines will appear in different colours depending on 
their meaning. Below is a list of the colours lines might be: 
 
• White - Normal time log entries that have not been reviewed by a supervisor 
• Red - Denied time log entries - when you click on these, a note will appear at the bottom of the 

screen telling you why the entry was Denied 
• Green - Time that has been approved by your supervisor 
• Grey - Time that appears on an invoice - it cannot be edited anymore 
 
For more information on the Edit Time screen, refer to that section. 
  
  
  
 
13.13. Can I remove the login security? 
 
TimeTiger can be set up with integrated security, so that it logs you in as soon as you log in to 
Windows. If you are an Administrator, you can change these settings in Options-Security. 
Otherwise, contact your system administrator. 
  
  
  
 
13.14. Why aren't the timers changing? 
 
If this is the first time you are running TimeTiger, you might be wondering how you can tell the 
timers are running. Well, they are, in the background. You will only see the timer change after the 
increment that was set up in the database when it was created. For example, if the database was 
set up to track time in increments of 0.25 hours, you will have to wait 15 minutes to see the timer 
change. For information on how this increment can be changed, see Options-Timers. 
  
  
  
 
13.15. Why can't I edit Clients, Projects, etc.? 
 
If you cannot edit, add, delete, or move Clients, Projects, tasks, etc. it is likely because you are 
not set up as an Administrator. Normal users can only change their own poperties. Only 

Administrators can edit or change other items in the Explorer view. For information on how to 
change a User's properties so they are an Andministrator, see the Explorer-Item Properties 
section. 
  
  
  
 
13.16. Why can't I change Tools...Options? 
 
Only Administrators can change TimeTiger Options. For information on how to change a User's 
properties so they are an Andministrator, see the Explorer-Item Properties section. 
  
  
  
 
13.17. If I'm a Supervisor, how do I edit my own time? 
 
As a supervisor, your time is automatically approved by TimeTiger (appears green and cannot be 
edited). To edit time that you have logged you must first mark the time as unreviewed (using the 
clear button). After doing so, you should notice that the time entry background is white. You can 
now edit your time. Don't forget to approve your time after you make this change. For more 
information on changing the approval status of Time Logs, see the section on Supervisor 
Approval. 
 
  
  
  
 
13.18. Why don't some of my users show up in an analysis? 
 
If a user doesn't appear in an analysis, it is either because they are inactive or they haven't 
logged any time yet. Remember that if you have Supervisor Approval enabled, a users time will 
not appear in reports or analysis until it is approved by a supervisor. 
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